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Porting SPMS features to Indico 
This document aims at providing an in-depth analysis of the SPMS features with regards to their 

Indico counterparts, identifying the features which are already handled by Indico, and those which 

would need to be added to Indico. It will also provide a porting path and a reliable estimate of the 

needed resources for the porting. 
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Definitions 
(Scientific) Program Chair: Head of the SPC 

(Scientific) Program Committee (SPC): Group of people determining the conference programme; 

propose and select invited abstracts; selects contributed abstracts; defines classification; defines 

schedule 

Scientific Advisory Board (SAB): Group of people who propose Invited Orals, and provide feedback 

after the conference on issues such as scientific programme and general organization. 

SPMS administrator: Super user; performs initial configuration and any task in the SPMS. Since 

SPMS was designed with a view to organizing the scientific programme, instances have always been 

delivered to the Scientific Secretariat or Editor, who have de facto had the privileges of SPMS 

Administrator 

Editors (or processors): group of people who edit conference proceedings (Indico equivalent: layout 

reviewer) 

Editor/QA: double check after initial processing. The editing process is managed in two parts: editing 

(or processing) papers, then quality assurance. The two activities follow each other (the life of a 

paper) but may be carried out in parallel. It is normally the same group of people carrying out editing 

and QA, but normally an editor does not edit papers he/she edited. It is however possible for the 

SPMS Administrator/SS/Chief Editor with all privileges to assign all papers to him/herself for QA. 

Reviewers or referees: group of people who does the paper peer review/content editing (Indico 

equivalent: content reviewer) (no more conference in JACoW use content review, so all related 

features are considered deprecated)  

Organizing Committee: Group of people in charge of the conference organisation at large. 

Local Organizing Committee: Group of people responsible for the local organisation of the event 

(location, registration, etc.) 

Conference Coordinator: The person with all privileges in SPMS. This is normally the scientific 

secretary or editor in chief 

Conference Chair: Chairperson of the conference 

Registration manager: single person responsible for the whole registration (usually same as financial 

responsible). This person has full privileges on the registration module. 

Registration staff: These people process the registrations, receipt of fees, etc. and are also 

responsible for on-site registration at the desk at the conference. 

Session coordinator: Accepts and rejects classifications of abstracts in a session, finalise the session 

schedule. In JACoW, these are the “Experts” who can accept/reject the proposals for re-classification 

and contributed oral selection 

Session chair: Chairperson of a session, introduces session and speakers, sometimes ensures timing 

is respected 
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Scientific Secretariat: helps the SPC with the programme definition process in SPMS (same rights as 

SPMS administrator) 

Abstract/QA: checks abstracts before SPC selects them (usually scientific secretariat) 

 

Extensive Listing of SPMS Features 
This part lists the SPMS features and for each identified feature, states whether it is actively used or 

deprecated, whether it exists in Indico or not, and whether it should be instantiated in Indico or not. 

Login Page 

 
The login page allows the user to select the privileges to activate. Useful to test interfaces but also to 
unclutter/clarify the overall conference interface when one has too many roles. Apart from the 
SS/ADMINISTRATOR, who indeed can login with different roles to test them, most users naeve only one or 
two privileges at a time. The lifetime of privileges also varies. View SciProg Reports is normally always 
available for OC/SPC members for example. But Propose Invited Orals will only be available for a selected 
few for the period of the proposals. 
 

Active In Indico To be added 

Yes No No 

 The indico interface provides action menu items which are tailored to 
each role and clearly separated in the menu structure, so this feature is 
probably less important in Indico. 
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Modify Your Profile 

 
The User can modify its profile data as well as subscribe to society membership and mailing lists 
 

Active In Indico To be added 

Yes Partly No 

 - User profiles should stay in the central JACoW 
repository and be synchronised with Indico 
using an LDAP gateway for ex. (as was done for 
indico-jacow.cern.ch) 

- User profile changes should thus be done 
directly on the central repository (not in Indico) 

- Society membership and mailing lists 
subscriptions fields do not exist in Indico 
profiles. They should anyway stay attached to 
the user profile in the central JACoW 
repository. 
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Home Page as Abstract Owner 

 
The User sees the list of abstracts he/she owns and for each one 

- Accept/reject editor’s changes (if the editor status is yellow) 
- Print the abstract details 
- Edit the abstract details 
- Change the authors 
- Upload the files for each session to which the abstract will be displayed 
- See the History of actions on this abstract 

The user can also submit a new abstract 
 
The log also shows e-mails sent to the individual depending on the mailing list. 
 
Hard copies are no longer required. This is a feature that can be switched on and off depending on the 
conference. Hard copies used to be handed in by authors upon arrival at the conference, filed by the Author 
Reception, and then used in the QA process to check that the editor’s pdf matched the author’s pdf. For a 
couple of years now it is not used. 
 
 

Active In Indico To be added 

Partly Partly Yes 

“Waiting for Hard 
copy” (Paper 
Hardcopy 
Required): 
deprecated 
 

In Indico: “View my 
abstracts” or “My 
contributions”, then “Edit” 
or “Material” or “Paper” 
 
 
 

- Add information to the View My abstracts list 
display: 

o Editor status 
o Referee status 

- Accept/reject editor’s changes 
- One process is rather hidden in SPMS is that 

when an abstract is accepted, a mail is usually 
sent to the owner announcing the acceptance 
and asking to confirm (by email) the actual 
participation to the conference. This could be 
added as a feature to the abstract list. 

- Add information to the abstract detailed 
view: 

o Full History 
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Home Page as Abstract Owner > Submit New Abstract 

 
Page to enter all details related to the new abstracts 
 

Active In Indico To be added 

Yes Partly Yes 

 The “Footnotes” and Funding 
Agency” fields are not default 
fields in Indico, but can very 
easily be added as custom 
fields. 

Add “TitleCase” feature 
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Home Page as Abstract Owner > File Upload 

 
This page allows the user to upload new files to the contribution. The user must select a file type, the 
platform which was used to create the master file. The user also has access to some specific JACoW 
checklist and must confirm that the uploaded manuscript conforms to the guidelines before actually 
uploading the file. 
It also provides a text and a link to verify the contribution metadata and edit it if necessary. 
 

Active In Indico To be added 

Yes Partly Yes 

 File types in Indico are 
“Folders” 

- It should be possible to enforce some file types 
according to the presentation type of the 
contribution. 

- Add platform type (as an option) 
- Add comments 
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Home Page as Abstract Owner > Accept/Reject Editors’ changes 

 
This page allows the user to accept or reject the changes made by the editor after the paper has been 
revised and assigned a yellow dot 

Active In Indico To be added 

Yes No Yes 

   

 

 

Overall Database Administration 

Overall Database Administration > Data Dictionary w/Dependencies 

 
Page showing statistics on the SPMS software code 
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Active In Indico To be 
added 

Yes Yes No 

 The closest information can be found on OpenHub: 
https://www.openhub.net/p/indico/analyses/latest/languages_summary 

 

 

Overall Database Administration > Email Utility (Repository) 

 
Generic mailing system to send emails to any people registered in the repository according to criteria: 
belonging to mailing lists, membership, affiliations, country, region, affiliation type. Used to invite people to 
submit or register to conferences. 
Title and body of the email can be defined and include substituted tags: 

https://www.openhub.net/p/indico/analyses/latest/languages_summary
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- Chair’s Email 
- Editor’s Email 
- Repository Name 
- Login URL 
- Name, First 
- Name, Last 
- Name, Middle 
- Name, Initials 

Active In Indico To be added 

Yes No Yes 

   Generic Mailing system 

 

Overall Database Administration > Invitees 

 
Creating the list of invitees for the conference 
This screen/functionality was designed for one conference series (Linac) which was originally “invitation 
only”. Entering the names of the invitees into the bulk load (option 2), or adding individual ones via the 
Option 2, meant that only persons entered here could access SPMS. This functionality was dropped by Linac 
some time ago so it is obsolete. However, Christine Petit-Jean-Genaz sometimes use this to allow individuals 
to submit an abstract when abstract submission is closed. It’s a sneaky back door quick fix  which can come 
in useful since it allows the author to submit the abstract whereas without this the Administrator/SS/Editor 
would have to do it. 

Active In Indico To be added 

Yes Yes No 

 In registration module. 
The current Indico process is a bit tedious: 
one has to manually select and send a mail to 
each invitee one by one. 
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Overall Database Administration > List of Invitees 

 
Lists all invitees to the conference. This screen is used to remove the persons who either should not be able 
to access the instance, or once the individual has submitted an abstract when submission is closed. 

Active In Indico To be added 

Yes Yes No 

 In registration module  

 

Overall Database Administration > Job Queue Status 

 
Show status of SPMS task queue 

Active In Indico To be added 

Yes Yes Yes 

 Through Celery Flower or RabbitMQ  Adding email sending 
queue management 
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Overall Database Administration > Privileges, Roles & Users > Authorize 

 
This page assigns specific roles to a list of users. These roles behave both as functional roles (granting 
privileges to its members) and as mailing lists. Some roles are pre-defined in the virgin repo, some others 
can be created from scratch depending on the needs. Can grant/remove privileges to a functional role. 
Rights given by privileges are detailed down the page. 

Active In Indico To be added 

Yes Yes, but not at this 
granularity level 

Yes 

   Add missing roles and privileges 

 Listing all roles and assigned users on one 
single page may be interesting 
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Overall Database Administration > Privileges, Roles & Users > Functional Roles 

 
Create/delete functional roles – Edit existing ones 

Active In Indico To be added 

Yes No No 

Vendor and 
abstract flags are 
deprecated 

  

 

Overall Database Administration > Privileges, Roles & Users > Privileges 

 
Create/delete privileges – Edit existing ones 

Active In Indico To be added 

Yes No No 

 “Activity Log” and “Validate IP 
address”: Deprecated 
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Overall Database Administration > Privileges, Roles & Users > Web Pages 

 
Create/delete web pages (correspond to SPMS functions) – Edit existing ones – Link a function with one or 
several privileges 

Active In Indico To be added 

Yes No No 

   

 

Overall Database Administration > System Parameters > Conference 

 
Sets basic conference data/options 
 

Active In Indico To be added 

Yes Partly Yes 
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 All parameters exist in the 
conference definition page or 
abstract management page or 
papers management page or 
registration page but: 

 Early registration 
deadline 

 Invitation-only 
conference 

 Auto-gen program code 

 Enable auto poster id 
assignment 

 Poster Police: policy for 
accepting poster 
publication 

 Early registration 

 Invitation-only mode 

 Management of program code 

 Poster policy: set of checks which are 
applied to posters and taken into 
account when deciding whether to 
publish a poster or not (poster manned, 
quality ok…). 

 

Overall Database Administration > System Parameters > User 

 
Controls different parameters related to users features 
 

Active In Indico To be added 

Yes Partly Yes 

 “Accepting Abstracts”: abstract 
submission dates and CfA activation 
button; this field is exclusively used in 
SPMS to define when abstracts are 
accepted; dates are not used; this 
gives the possibility to have soft 
deadlines which conferences usually 
favor 
“Allow Poster Transparency Uploads”: 
Indico allows submitters to upload any 
type of document including poster 
files. 
“File Upload Threshold”:  
“Freeze user Updates to abstracts”: 
Indico’s “modification deadline” 

 “Accepting abstracts”: check if late 
submitters mechanism is acceptable 
(should be) 

  “File Upload Threshold” 

 “Hide program codes” 

  “Sub-classification required” 
 



16 | P a g e  
 

“Hide Program Codes”: No 
“Copyright required”: Deprecated 
“Paper Hardcopy”: Deprecated 
 “Sub-classification Required”: No 
“Users can see the Agenda”: Yes, 
deactivate the corresponding menu 
link 
“VISA Invitation Letter”: No – Can be 
added as a registration form free-text 
field. 

 

Overall Database Administration > System Parameters > URLs 

 
Defines various URLs displayed on the event interface 

Active In Indico To be added 

Yes No No 

  The various URLs and info sources will be 
added directly to the event using Indico’s 
flexible content and interface management 
system. 
If needed a pre-defined event containing basic 
information can be created which can be then 
cloned to create conferences. 
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Overall Database Administration > System Parameters > Email 

 
Defines various email addresses as well as email-related behaviours throughout the application 

Active In Indico To be added 

Yes Partly Yes 

“Hotel handling”: 
deprecated 
 

““From” email address”: in Indico 
general system configuration 
“Administrator’s Email Address”: Indico 
event support email address; This e-
mail is the SS/Editor’s e-mail address, 
the “reply to” e-mail address. It is not 
the “technical” person, it is the person 
who is interfacing between the 
contributors and the organizers, the 
SS/Editor. 
Affiliation/profile requests: should stay 
in JACoW 
“Program chair email”:  can be added 
through Indico flexible interface 
customization 
“SMTP Host”: In the central 
configuration of the Indico server 
“Send Co-author email”: should stay in 
JACoW 
“Send Email to administrator for 
abstract update”: Use the Indico “Email 
notification on submission” field 
“Send Email to Administrator for New 
Abstract”: Use the Indico “Email 
notification on submission” field 
“Send Email to Administrator for New 
Accounts”: should stay in JACoW 
“Send Email to LOC for Abstract 
Updates”: Use the Indico “Email 
notification on submission” field 
“Send Email to LOC for New Abstract” : 
Use the Indico “Email notification on 
submission” field 

 “cc all email” 

 Creation of profiles for co-authors 
unknown to the system 
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“Send Email to Owner for New 
Abstract”: Indico sends a mail by 
default to the abstract submitter. When 
a new abstract is created and the 
“primary author” adds co-authors who 
do not yet have profiles, i.e. he creates 
profiles for co-authors, the co-authors 
receive an e-mail informing them that a 
profile has been created and inviting 
them to login and check it is correct, 
creating an account and making them 
the “owner” of the profile. 
 
 

 

Overall Database Administration > System Parameters > Web Configuration 

 
Defines various parameters related to the web access and http api 

Active In Indico To be added 

Yes Yes No 

 “Secret Passphrase”: Will use Indico HTTP 
API keys 
“Secret passphrase for paper Upload”: Will 
use Indico HTTP API keys 
“Secret passphrase for paper download”: 
Will use Indico HTTP API keys 
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“Author File Upload script”: file upload 
and storage is integrated to Indico 
“DTree Javascript”: Not needed 
“Editor Download Script”: Indico provides 
direct file download mechanisms 
“Repository Profile URL”: Handled by the 
profile sync mechanism already in place 
and using ldap proxying 
Other parameters: Natively handled by 
Indico 

 

Overall Database Administration > System Parameters > SPMS Configuration 

 
Defines various parameters mostly related to Abstracts and Schedule 

Active In Indico To be added 

Yes Partly Yes 

 “Additional Credit Line”: Use BoA 
“Additional Text” field 
“CSS URL”: Use the Indico event-
specific local CSS sheet 
“Conference Program Report 
Interval”: Not needed (used in SPMS 
only for drawing the synoptic 
program table) 
“Date Input Format”: imposed by 
Indico 
“Maximum Abstract Length”: Indico 
CfA “Max Length” field 

 Abstract Book Extract - Initials Only: Add 
to book of abstracts configuration 

 “Allow editor to QA a paper they 
edited”: in paper review module. 

 “Paper ID Oral Sequence length” 

 “Paper ID Poster Sequence Length” 
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“Maximum Footnote Length”: Indico 
CfA “Max Length” field 
“Maximum Funding Agency Length”: 
Indico CfA “Max Length” field 
“Minutes between syncs”: 
Synchronisation of the local db with 
the central repo. 
“Rebuild CTX Indexes Online”: Not 
needed 
“SPMS Version String”: Not needed 
“Standalone Database”: Not needed 

Overall Database Administration > System Parameters > Image URLs 

 
Defines various image URLs to be used in the SPMS interface 

Active In Indico To be added 

Yes No No 

 Not needed in Indico  

 

Overall Database Administration > System Parameters > Registration 

 
Defines various parameters related to the registration process 

Active In Indico To be added 
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Yes Partly Yes 

“Hotel handling”: 
Deprecated 
 

“Credit Card Vendor”: Indico e-payment 
module 
“IP Address Environment Variable”: Not 
needed 
 “Local Currency Symbol”: Indico e-
payment module  
 “Payment Email Text”: Indico e-
payment module 
“Payment prompt notes”: Indico e-
payment/registration module 
“Registration List is Public”: Will be in 
Indico 1.9.6 

 Few e-payment modules 

 Registration Invoices 

 Registration “Late Fee Grace 
Period” 

 Allow external registration 
systems to update Indico with 
registration status 

 

 

Overall Database Administration > System Parameters > Hotel Handling 

 
Defines various parameters related to the hotel handling 

Active In Indico To be added 

No No No 

   

 

Overall Database Administration > System Parameters > Experts/Referees 
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Defines various parameters related to the paper review process. This is the Refereeing Module … Currently 
no JACoW conference series are refereeing. Low priority therefore. 
 

Active In Indico To be added 

Yes Partly Yes 

 “Email Notice When PDF File Is 
Uploaded” : hard-coded into Indico 
“Email Notice When Paper Assigned”: 
Hard coded into Indico 
“Refereed conference”: paper review 
activation in Indico 
“Referees per paper”: Indico content 
reviewers (as many as necessary). 

 Auto Assignment of papers 

 “Expert instructions”: be able to 
customize the email sent to newly  
appointed reviewers with instructions 

 Be able to inform conference 
managers when a paper is revised or 
declined 

 Create Program chair 

 Create Program committee 

 

Overall Database Administration > System Parameters > PC 

 
Defines various parameters related to the program committee activities 

Active In Indico To be added 

Yes Partly Yes 

 Freeze user updates to classification 
Freeze user updates to presentation 
type: in both cases the abstract 
modification deadline can be used. 
 

 Create Program committee 

 Configure PC members rights to: edit 
abstract, propose invited orals, change 
presentation types (same as edit), 
reclassify abstracts  

 Implement invited orals management 
process 
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Overall Database Administration > System Parameters > Post Conference 

 
Defines various parameters related to the conf proceedings publication 

Active In Indico To be added 

Yes No Yes 

   Associate an ISBN with the conference 
(assigned by JACoW) 

 Associate an ISSN with the conference 

 Add publication date 

 Add publisher field 

 Add URL to the conference papers 
repository in JACoW 

 Add a INSPIRE Conference # 

 Add the description of the conference in 
INSPIRE 

 

Overall Database Administration > System Parameters > E-Dot Board 

 
Defines various parameters related to the e-dot board feature 

Active In Indico To be added 

Yes No Yes 

   E-Dot Board to be implemented as a 
separate module, or plugin? Or 
external script ? 
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Scientific Program Administration 

Scientific Program Administration > Abstract Attributes 

 
Allows the creation of specific attributes for tracking various abstract statuses (ex. Invited Oral Pending, 
Invited Oral Accepted, Invited Oral Declined), or registrant statuses (Student Grant Offered, Accepted, 
Declined…); Yes/No options 
Note this works on contributions and on profiles. It is a very valuable tool for organizers to monitor different 
activities and people. This will not be implemented on indico for profiles as profiles will be managed 
centrally on the profiles DB. 
 

Active In Indico To be added 

Yes Partly Yes 

  Fields can be added to the 
abstract submission form but 
cannot be hidden from public. 

 Fields can be added and hidden 
in there g. forms 

 Make some additional fields for 
abstracts only available to admins. 

 

 

Scientific Program Administration > Abstract Reclassification 

 
This page allows to search for specific abstracts in a classification or presentation type and propose to 
change their classification and/or presentation type 
 

Active In Indico To be added 
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Yes Partly Yes 

  The CfA review process allows 
the Track reviewers to propose 
a different track, but not a 
different presentation type 

 Allow track experts to propose a 
different presentation type and 
moderate the change of 
presentation types. 

 

Scientific Program Administration > Classification > Main Classifications 

 
This page allows to create main classifications, to nominate experts, and assign sessions to each of them. 
Experts can have several roles: Session coordinator, propose to reclassify, moderate reclassification, 
propose to change presentation type, moderate change of presentation type, referee for papers (standard 
and moderator). 
This screen is first and foremost to classify contributions. The link to the Experts tables was introduced for 
“fine grained tuning” so that one can give privileges to specific persons per main classification. It’s finer than 
when one assigns a privilege via the Authorize screen. Used for PC activities: verification of main and sub-
classifications upon abstract submission, and selection of contributed orals after general abstract 
submission. 
While some specialized conferences only have Main Classifications, many use the combination of Main PLUS 
Sub-classification. For the larger conferences this combination is essential. 
The primary use of Main Classifications combined with Sub-classifications is to schedule the POSTERS. When 
there are 1400 posters to schedule, the main plus sub-classification allows for a fine tuning. 
This is far more important than the SPC jobs of checking main plus sub-classifications are correct, and for 
selecting the contributed orals. 
 

Active In Indico To be added 

Yes Partly Yes 

 All processes are in Indico except the 
change of presentation types. 

 Classifications: Tracks 

 Expert for proposing changes: 
track coordinators 

 Session coordinator: can 
approve/reject changes 

 Experts for accepting changes: 
currently event managers in 
Indico 

 

 Allow track reviewers to propose a 
different presentation type 

 Add granularity level for accepting 
changes without being event 
manager 

 Assign sessions to track (for the 
automated poster assignment) 
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Scientific Program Administration > Classification > Sub Classifications 

 
This page allows to create sub classifications, and assign sessions to them. 
 

Active In Indico To be added 

Yes No Yes 

   Add sub-tracks 

 

Scientific Program Administration > Classification > Combine Main and Sub Classifications 

 
This page allows to create the hierarchy between main and sub classifications 
To be more specific, this page allows the fine tuning with the association of the main plus sub-classification 
(of POSTERS), which are then assigned to a poster session, i.e. scheduled in time and space. 
Note it is possible to assign one Main plus Sub-classification to more than one session, for instance when 
there are too many contributions in one main plus sub-classification to fit into one area. Setting two 
sessions will fit the posters into several areas, via the sorting protocol specified in the Program Code Sort 
Order. 
 

Active In Indico To be added 

Yes No Yes 
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   Assign sub-tracks to tracks 

 Assign Session to subtrack/track (for 
posters only) 

 Used for automated session 
assignment 

 

Scientific Program Administration > Classification > Import Classifications 

 
This page is used to import classifications/sub-classifications from another SPMS instance. 
 

Active In Indico To be added 

Yes No Yes 

 All via straight SQL Ensure that this structure can be cloned 

 

Scientific Program Administration > Contributions Log Codes 

 
This page is used to create/delete contribution log codes, and configure the log codes 

- Do Not Delete: indicates that the code should not be deleted 
- Srtf Function: Sort and File – the Author Reception screen where they can enter comments in the 

log, convey the author’s comments on for example an editor’s editing comments. 
- Activity Log: Show this code on the activity log 
- Chart Flag: This is used for generating a chart associated with the status. These charts are 

sometimes used at the conference websites to show the abstract submission, paper upload, 
delegate registration, etc. 

- Status Code: The status code refers to the status of editing (probably not used anymore) 
 

Active In Indico To be added 

Yes Partly Yes 

  Possibility to add customised status codes 
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Scientific Program Administration > Daily Events (for Program) 

 
This page is used to create daily events for the conference program (breaks, lunches etc.). This is apparently 
very rarely used … Christine believes it was created at the request of the PAC’09 Editor .. and not used since 
… As far as she recalls it’s a little over rigid since coffee breaks/lunches have to take place at exactly the 
same time. 
 

Active In Indico To be added 

Yes Yes No 

 Available by creating “breaks” in the 
conference timetable 

 

 

Scientific Program Administration > Generate Paper TOC Values 

 
This page provides a view of all papers submitted to proceedings with their page number. Christine thinks 
that the TOC.html is only used for “pre-press”, without page numbers. 
 

Active In Indico To be added 

Yes No Not sure this is still needed??? 
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Scientific Program Administration > Location Codes 

 
This page allows to create/delete locations (rooms where conference presentations or poster sessions take 
place), each with a description and capacity. The Location Code is normally included in the programme 
code. The capacity is used when automatically assigning programme codes to posters. If there are more 
contributions in a main plus sub-clasification than can fit into one location, assignign 2 locations for the 
same main plus sub-classification combination will make a flow over several locations. 
 

Active In Indico To be added 

Yes No Yes 

 Rooms in Indico are only available as 
free text, except for locally defined – 
CERN – rooms, which also include 
capacity. In SPMS, the capacity is only 
used for posters area where it 
represents the maximum number of 
posters which can fit in the room. 
Location codes are used to generate 
contribution programme codes 

Necessary for automated posters 
assignments. 
Also needed in case contribution 
programme codes must be implemented. 
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Scientific Program Administration > Presentation Types (Contributions) 

 
This page allows to create/delete presentation types for contributions together with some additional 
parameters: 

 Presentation Type Code: Poster/Oral (only influences upload options aftwards) 

 Max Pages: maximum number of pages for the final paper: only used as a reference for the editor 
manual checks. 

 Editor Only: the types marked Yes can only be assigned by editors; The Editor Only means that only 
the SS/Editor can see the different types of presentation possible. For example, when an author 
submits an abstract he can see only what the SS/Editor wishes him to see. For IPAC, only the 
“poster” option is “visible” for submitters. Other conferences allow “poster” as well as for example 
“oral if selected”, or “oral poster” … The SS/Editor limits via this parameter what is seen by persons 
with no privileges 

 Reclassify: the types marked Yes can be reassigned by editors; Again, this is for the 
SS/Editor/Administrator to decide what is seen by others 

 Sort order: display order 

 Include In Paper: use the presentation code to compute the paper ID – usually not used 

 Propose Oral: presentation types which appear when an SAB member creates an invited oral 
 

Active In Indico To be added 

Yes Partly Yes 

 Presentation types can be defined in 
Indico (General Settings > Types of 
contributions) but do not have the 
parameters present in SPMS. 

Parameters for types of contributions: 

 Presentation Code 

 Poster/Oral 

 Max Pages 

 Editor Only 

 Reclassify 

 Include in paper: only if programme 
codes should be implemented 

 Sort Order 

 Propose Oral 
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Scientific Program Administration > Presentation Types (Sessions) 

 
This page allows to create/delete presentation types for sessions; these are just codes used to generate 
program codes from the sessions. 
 

Active In Indico To be added 

Yes No Maybe 

  Add session type codes only if programme 
codes should be implemented 

 

Scientific Program Administration > Profile Search/Edit > Alphabetical List 

 
Search for a user profile through alphabetical list; Select user profile and edit it. 
 

Active In Indico To be added 

Yes Yes No 
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 This option exists only to the Indico server 
administrators 

User Profiles should be modified centrally 
on the JACoW repo and synced to the 
Indico server. 

 

Scientific Program Administration > Profile Search/Edit > Create New Profile 

 
Create a new user profile 
 

Active In Indico To be added 

Yes Yes No 
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 Should be done on the central repo User Profiles should be created centrally on 
the JACoW central repo and synced to the 
Indico server. 

 

Scientific Program Administration > Profile Search/Edit > Search/Edit 

 
Search for a user profile through simple search form then edit the profile. 
 

Active In Indico To be added 

Yes Yes Yes 

 This option exists only to the Indico 
server administrators 

User search returns close matches 

 

Scientific Program Administration > Proposed Invited Oral Priority Codes 

 
Defines the list of priorities the SPC members will be able to select when assessing invited oral proposals.  
Indeed, the SS/Editor/Administrator needs to be able to create new/different priority Codes 
Christine sometimes adds another priority during the meeting: Reserve. At the end of the SPC meeting she 
asks that what is First Priority is accepted. She asks that the SPC indicates from the Second Priorities a 
number of Reserves. She then deletes the 2nd and 3rd priorities leaving the SPMS with only First Priority 
and Reserves. 
 

Active In Indico To be added 

Yes No Yes 
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 Should this be flexible or is there a 
recurring schema? 

Let the event manager define the list of 
priorities for evaluating proposed invited 
orals. 

 

Scientific Program Administration > Restore Withdrawn Abstracts 

 
Allows to restore an abstract that has been withdrawn by its submitter 
 

Active In Indico To be added 

Yes Yes No 

 In the Indico abstract detail page, use 
the “back to submitted” option 

 

 

Scientific Program Administration > Sessions 

 
Create/Delete Sessions, and associate chairs. The title of the session is entered “free hand” by the 
SS/Editor/Administrator and this can be used as a “header” in the programme booklet. 
 

Active In Indico To be added 

Yes Yes Yes 

 Indico equivalent: Session Block Add a page to list all sessions/session blocks 
Add automated session code generation and 
session type if programme codes should be 
implemented 

 

Scientific Program Administration > Validate Paper ID Sequence 
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This screens shows the list of paper IDs in order to identify gaps. Absolutely necessary during the run up to 
the conference for the SS/Editor/Administrator to be able to re-sequence contributions around withdrawn 
contributions 
 

Active In Indico To be added 

Yes No Maybe 

 Indico equivalent: contribution IDs needed if programme codes should be 
implemented 

 

Scientific Program Administration > Withdraw all proposals with no priority 

 
Utility screen to withdraw all proposals without any priority given. This utility is used to remove all of the 
proposals for invited orals that are 2nd and 3rd priority. 
This is used in connection with invited oral presentations. When the SPC is working it decides three types: 
1. Accepted for invited oral proposals (first priority) 
2. Reserve or backup (second priority) 
3. Rejected 
This screen is thus used to remove the 3. Rejected proposals. 
 

Active In Indico To be added 

Yes No Yes 

  Listing all proposals w/o priority, then 
withdraw them 

 

Scientific Program Administration > Withdraw all rejected proposals 
 

Utility screen to withdraw all proposals which have been rejected. This is used by the 
SS/Editor/Administrator to remove rejected proposals for invited oral presentation which had 2nd priority 
(reserve or backup). 
 

Active In Indico To be added 

Yes No No 

  Currently rejected proposals in Indico do not 
become contributions – which is probably 
enough. 
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Scientific Program Administration > Program Code Assignment > Assign/Move Paper IDs 

 
Utility screen to move one contribution to a different session. 
This is an essential part of the functionality. 
When the assignment of poster programme codes has been made, in particular when it’s an IPAC with 1400 
contributions, we see a number of “disjointed authors”, i.e. one author presenting more than one poster in 
several areas. This screen allows the SS/Editor/Administrator to manually move contributions around. 
Once this is done, i.e. right at the very last minute, we disable the “reset all poster paper IDs” since this 
would re-assign the poster programme codes and all of the manual modifications would be lost. 
The Reset All Poster Paper IDs should thus only be used ONCE, prior to the manual adjustment, and then be 
disabled. 
 

Active In Indico To be added 

Yes Partly Maybe 

  Indico includes the possibility to 
easily move one contribution 
from a session to another 

 It does not include a feature to 
show that the same author 
appear in different sessions. 

 Reset All Poster Paper IDs if 
programme codes should be 
implemented 
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Scientific Program Administration > Program Code Assignment > Program Code Sort Order 

 
Utility screen to set the sorting order of the program codes according to various criteria. 
Essential for automatically assigning the poster programme codes.This allows posters to be grouped by 
specific criteria for the automatic assignment of codes. 
 

Active In Indico To be added 

Yes No Maybe 

  Only if program code should be implemented: 

 Program code sorting options 

 

Scientific Program Administration > Program Code Assignment > Bulk Assignment 
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Utility screen to bulk assign specific sessions and presentation types to contributions returned by a search 
request 
This is a feature developed for multiple programme code assignments. 
The automatic programme code assignment for poster sessions is the first activity. 
Then, via the “bulk” assignment one has to search for the type, i.e. student poster or oral poster, and assign 
the sessions to them. 
This will result in assigning more than one programme code to those contributions presented more than 
once. 
 

Active In Indico To be added 

Yes No Yes 

   

 

Scientific Program Administration > Program Code Assignment > Session Search 

 
Utility screen to assign program codes to contributions returned by a session search request. This is a useful 
feature for authors/participants to be able to see a session at a glance. 
 

Active In Indico To be added 

Yes No Yes 
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Hotel Administration 

 
 

Active In Indico To be added 

No No No 

The whole module is 
deprecated 

  

 

Program Committee 

Program Committee > All Orals 

 
Utility screen to list and export (HTML or CSV)  all oral contributions. This report generates an excel 
spreadsheet which can be merged with a standard letter to create the individual invitations to speakers 
 

Active In Indico To be added 

Yes Yes No 

 List of abstracts/contributions  
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Program Committee > Change Abstract Classification and/or Presentation Type 

 
Utility screen to retrieve some abstracts according to some criteria (classification, sub-classification, status) 
and propose a change in their classification and/or presentation type 
 

Active In Indico To be added 

Yes Partly Yes 

 Only classification can be changed Allow proposing new presentation types 

 

Program Committee > Contribution Counts: Classification – Presentation Summary 

 
Shows a table with statistics of repartition of abstracts per classification and type of contributions 
 

Active In Indico To be added 
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Yes No Yes 

  Summary/stats page for 
classification/presentation types assignments 

 

Program Committee > Invited Extract 

 
Utility to export the list of Abstracts/Contributions to Excel 
 

Active In Indico To be added 

Yes Yes No 

 Export feature in Abstract/Contribution 
management page 

 

 

Program Committee > Overview of Oral Presentations 

 
Utility to download a list of all oral presentations showing paper ID, presentation title, and speaker name 
 

Active In Indico To be added 

Yes Yes No 

 Export feature in Contribution 
management page 

 

 

Program Committee > By Page Count 
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Utility to show a table summarising the number of paper pages per type of presentation 
 

Active In Indico To be added 

Yes No No 

Is this used? For 
what purpose? 

  

 

Referee 

Referee > Editor / Proceedings Administration 

 
This page allows searching for papers to be processed by editors, then change the editing status of a paper. 
 

Active In Indico To be added 

Yes Partly Yes 

 This concerns the layout review process 
in Indico 
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Referee > List My Papers 

 
This page lists all papers assigned to the user as an editor and gives access to many features 

 View detailed abstract 

 Edit abstract 

 Abstract log 

 Email authors 

 Upload and download files 

 Set editor status 
 

Active In Indico To be added 

Yes Yes Yes 

 The equivalent in Indico is in “Paper 
Reviewing”->”Layout Reviewer Area” 

 The list in Indico lacks a lot of 
options which should be accessible 
directly in the page together with 
links to paper files. 

 Colored dots may be assigned to 
each status for better visual 
representation. 
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Referee > Master Status Report 

 
This page lists papers in the reviewing process filtered by editor and referee statuses, with their status, list 
of files and evaluations 
 

Active In Indico To be added 

Yes Partly Yes 

   The dots layout reviewer statuses 
have to be implemented 

 The overview list itself could be 
implemented based on the “Assign 
paper” existing list with additional 
functionality: adding final QA, file 
list etc. 

 

Referee > Referee Module 

 
This page summarises the status of the refereeing process 
 

Active In Indico To be added 

Yes   
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Referee > Referee Status Codes 

 
This page allows to define the status codes used by the referees – None are available by default. Each status 
has associated configurations which determine the behaviour of the system when the status is selected: 

 Sort order: sort order in drop down lists 

 Email Msg: body of the email sent to the abstract owner when the status is assigned 

 Image URL: URL of the image representing the status in the interface 

 Ok to Upload: If set to yes, allows the abstract owner to upload files 

 Send Email Notice: Send a mail to the abstract owner when the status is assigned 

 Publishable: Set the paper publishability to ok when the status is assigned (if all other criteria are 
met) 

 Declined: Indicates that the paper is rejected when the status is assigned 

 Revisions: Indicates that the abstract owner can revise its paper when the status is assigned 

 E-Dot Board related variables: 
o Edot Board Text 
o Px Width 
o Px Height 
o Edot Fg Color 
o Edot Bg Color 

 

Active In Indico To be added 

No Partly No 

 Available codes in Indico for referees 
(Indico equivalent: content reviewer) are 
“accept”, “to be corrected”, “reject”. One 
can also add custom statuses.  
Same statuses are defined for both 
reviews (content and layout) 
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Referee > Referee/Editor Status Code Matrix 

 
This page shows for each combination of status in layout/content refereeing processes if the author has the 
right to upload files. 
When the Refereeing Module was used, once the Editor had edited a paper the author no longer had access 
until it had been through the refereeing process. If the Referee found things to be corrected the paper went 
back to the author with the comments of the Referee and could re-submit. If the Referee accepted the 
paper, the author could no longer access of modify the paper. 
 

Active In Indico To be added 

Yes Partly Yes 

 In Indico once the paper file has been 
uploaded, it cannot be modified unless 
the status is changed to “to be 
corrected”. This should be changed so 
that the file can still be uploaded if no 
referee/editor is assigned to the 
paper. 
Currently the Indico referee has to 
mark the status “to be corrected” in 
order for the author to be able to 
revise the file. The revision should be 
possible when layout or content 
reviewer set the status to “to be 
corrected”.  
 

 Let the author revise the paper as 
long as it is not assigned to any 
reviewer, or when either the content 
or layout reviewers assign status “to 
be corrected” 

 Add status matrix with selectable 
uploadability 

 

Editor/Proceedings Administration 

Editor/Proceedings Administration > *** List PDF Only Papers 

 
This page lists the papers which have only a PDF submitted. And allows self-assignment as an editor 
 

Active In Indico To be added 

Yes No Yes 
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Editor/Proceedings Administration > Abstract Search/Edit 

 
This page allows to search for abstracts according to various criteria: 

 Contribution ID range 

 Paper ID 

 Scheduling Date 

 Session 

 Free text search on titles and abstracts (with exact match option) 

 Author name 

 Classification (main and sub) 

 Presentation type 

 Presentation group (oral or poster) 

 Free text search on Affiliation (option to exclude affiliation of co-authors) 

 Some reviewing statuses 
o Editor status 
o Referee status 
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o Requires initial Q/A 
o Final Q/A’ed 
o Has source files been uploaded 
o What is the source platform 
o Has PDF been uploaded 
o Have slides been uploaded 
o New affiliations 
o Copyright form – Still needed for IEEE documents for ex. should be generalised as 

“necessary documents” 

 Custom abstract statuses 
And sort results according to (3 levels of sorting): 

 Paper ID 

 Author 

 Contribution ID 

 Main Classification 

 Sub Classification 

 Presenter’s Affiliation 
And select which fields are displayed on the result page in addition to the abstract title 

 Co-authors 

 Abstract text 

 Funding Agency 

 Presentation Type 

 Main Classification 

 Sub Classification 
The search page is also available for general users 
The results page gives access to all features available for each contribution: 

 Withdraw 

 Define owner 

 Define editor 

 Perform Initial abstract Q/A 

 Perform Referee Assessment 

 Download files 

 Upload Files 

 Sort/File/Edit 

 Perform Final Q/A 

 Print abstract data 

 Show action log on abstract 

 Add co-authors 

 Email authors 

 Profile of author 

 Show details of sessions showing the contribution/ Add session 
 

Active In Indico To be added 

Yes Partly Yes 

  In Indico two different objects 
represent a single 
contribution: it is called 
abstract before approval and 
contribution after. This means 
there are currently two search 
interfaces: one for abstracts, 
one for contributions. 

 Add to filtering criteria: 
o Contribution ID range 
o Paper ID (if program codes 

should be implemented) 
o Scheduling date 
o Session blocks 
o Title and abstract free text 

search 
o Presentation Group 

(oral/poster) 
o Affiliation free text search 
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o Layout and content review 
statuses 

o Requires initial Q/A 
o Final Q/A’ed 
o Has source files been 

uploaded 
o What is the source platform 
o Has PDF been uploaded 
o Have slides been uploaded 
o Copyright form  
o Custom abstract statuses 

 Improve sorting options 
o 3 levels on 
o Paper ID 
o Author 
o Contribution ID 
o Main Classification 
o Sub Classification 
o Presenter’s Affiliation 

 Add results display options 
o Funding agency 

 Add easy access to all contribution 
related features: 

o Define owner 
o Define editor 
o Perform Initial abstract Q/A 
o Perform Referee Assessment 
o Download files 
o Upload Files 
o Sort/File/Edit 
o Perform Final Q/A 
o Print abstract data 
o Show action log on abstract 
o Add co-authors 
o Email authors 
o Profile of author 
o Show details of sessions in 

which the contribution is 
scheduled / Add session 

 

 



50 | P a g e  
 

Editor/Proceedings Administration > Abstract Search/Edit > Edit 

 
This page gives details on the contribution data and allows to modify various fields: 

 Title 

 Presentation type 

 Main classification 

 Sub classification 

 Abstract 

 Footnotes 

 Funding Agency 

 Session 

 Time 

 Duration 

 Session Seq 

 Streaming video URL 
Includes a special feature to automatically set the proper title case 
Allows to record initial abstract Q/A 
 

Active In Indico To be added 

Yes Partly Yes 
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 All the fields can be modified from the 
contribution management page except 
footnotes and funding agency.  
Footnotes and funding agency can be 
added as custom fields 

 Add TitleCase feature 

 Add recording of initial Q/A 

 Add Custom abstract statuses 

 

Editor/Proceedings Administration > Abstract Search/Edit > Withdraw 

 
This page allows to withdraw the abstract 
 

Active In Indico To be added 

Yes Yes No 

   

 

Editor/Proceedings Administration > Abstract Search/Edit > Owner 

 
This page allows to change the owner of the contribution 
 

Active In Indico To be added 

Yes Yes No 

 In abstract detailed page: “change 
submitter” 
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Editor/Proceedings Administration > Abstract Search/Edit > Editor 

 
This page allows to change the editor of the contribution 
 

Active In Indico To be added 

Yes Yes No 

 In contribution management, “Paper 
Reviewing” tab, “Assign a layout 
reviewer” 

 

 

Editor/Proceedings Administration > Abstract Search/Edit > Referee 

 
This page allows the referee to change the status of the abstract and enter some comments (to author and 
private). The notes are viewable by accounts with editor, referee, admin, sort file and edit roles. In general, 
those with proceedings-production activities. 
 

Active In Indico To be added 

Yes Partly Yes 

 Available in contribution management, 
“Paper reviewing”, “Assess Content”. 
Private notes are not available 

Private notes 

 

Editor/Proceedings Administration > Abstract Search/Edit > QA 
 

Clicking on the QA link automatically sets the Initial abstract QA flag to Yes for the contribution 
 

Active In Indico To be added 

Yes No Yes 
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Editor/Proceedings Administration > Abstract Search/Edit > Sort/File/Edit 

 
This page allows the editor and referee to perform various actions on the contribution: 

 Change title 

 Enter Q/A values 
o Abstract Initial QA Performed 
o Copyright form Received 
o Paper Copy Received 

 Change editor status 

 Change referee status 

 Add comments 
 

Active In Indico To be added 

Yes Partly Yes 

 The features are available in different 
screens.  
The comments are displayed in the 
log 
Can the QA values be entered 
anywhere else (the initial QA can be 
entered at the abstract detailed page/ 
search result)??? 

Central place where the administrator can 
modify various contribution parameters. 

 Change title 

 Enter Q/A values 

 Change editor status 

 Change referee status 

 Add comments 
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Editor/Proceedings Administration > Abstract Search/Edit > Final QA 

 
This page allows the QA team member to send an email to the author, upload a PDF file set the final QA 
status, add a comment, get another paper to QA and modify some contribution fields: 

 Title 

 Authors 

 Total Pages 
The comment will be visible in the log 
  

Active In Indico To be added 

Yes Yes No 

 That’s the referee page  

 

Editor/Proceedings Administration > Abstract Search/Edit > Print 

 
This link allows to print data about the contribution 
 

Active In Indico To be added 

Yes Yes Yes 
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 Equivalent to the Indico 
contribution PDF export with a few 
fields missing 

 Add to the PDF export: 
o Submitted and modified dates 
o Paper ID (if program codes are 

implemented) 

 

Editor/Proceedings Administration > Abstract Search/Edit > Log 

 
This link allows to print data about the contribution 
 

Active In Indico To be added 

Yes No Yes 

  o Preserve the full history of 
all changes applied to an 
abstract/contribution and 
display them in a Log page 
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Editor/Proceedings Administration > Abstract Search/Edit > Authors 

 
This pages allows to modify the contributions authors 
The field on leave is used to construct the affiliations list appropriately.  
 

Active In Indico To be added 

Yes Yes No 

 In the contribution edition page The JACoW author sort order will have to 
be taken into account in the creation of 
proceedings as Indico will keep an 
alphabetical ordering when displaying 
author lists. 
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Editor/Proceedings Administration > Abstract Search/Edit > Email 

 
Generic interface to send emails to authors of one or several contributions using substitutes values. 
 

Active In Indico To be added 

Yes Yes Yes 

 The “Author List” page from the Indico 
contribution list page allows to send 
emails using the local mail client and 
without substitutable fields 

Add generic author emailing option 
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Editor/Proceedings Administration > Abstract Search/Edit > Sessions 

 
This page lists the sessions in which the contribution will be displayed and allows to remove some, add new 
and make primary 
 

Active In Indico To be added 

Yes Yes No 

 In Indico this can be changed from the 
contribution detailed page. 
Indico will not support the possibility to 
show one contribution in different 
sessions, but will rather suggest the 
duplication of contributions 

 

 

Editor/Proceedings Administration > Activity Log - Staff 
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This page lists statistics of activity for each editor: 

 Number of dot reassignment 

 Number of failed final QA (papers which got a failed final QA from the person) 

 Number of passed final QA (papers which got a passed final QA from the person) 

 Number of papers re-assigned (self-reassignments) 

 Number of Transparencies assigned to the person 

 Number of Transparencies completed by the person 

 Number of Transparencies reassigned by the person 

 Number of edits completed 

 % of QA failures on papers edited by the person 

 % of initial dot statuses 
 

Active In Indico To be added 

Yes No Yes 

   

 

Editor/Proceedings Administration > Editor Source File Types 

 
This page lists the available source file types that editors can select to process and allows to add others. 
This is used when the editor selects which paper he/she wants to be assigned to, in the statistics, in the file 
upload form. 
 

Active In Indico To be added 

Yes No Yes 
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Editor/Proceedings Administration > Email > Email History 

 
This page lists every single email ever sent by SPMS for this conference 
 

Active In Indico To be added 

Yes Yes No 

 This currently stands in the event log 
page 
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Editor/Proceedings Administration > Email > Email Utility 

 
Email utility which allows to send emails to authors of contributions filtered by various criteria: 

 Some statuses in the history log 

 Custom contribution attributes 

 Classifications 

 Editor status 

 Referee status 

 Presentation generic type (oral/poster) 

 Presentation specific type 

 Session type 

 Affiliation free text match 

 No files uploaded 

 No related registration 

 Police Ok; No file 

 QA passed; Police failed 

 Contribution ID range 

 Paper ID range 
The email body message can be written using substitutable fields 

 [[Chair's Email]]  

 [[Copyright URL]]  

 [[Editor's Email]]  
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 [[Login URL]]  

 [[Paper ID]]  

 [[Paper Title]]  

 [[Presentation Type]]  

 [[Publications URL]]  

 [[Search URL]]  

 [[Session Date]]  

 [[Session End Time]]  

 [[Session End Time - 30]]  

 [[Session ID]]  

 [[Session Location]]  

 [[Session Start Time]]  

 [[Session Start Time - 30]]  

 [[Session Title]]  

 [[Recipient's Name]]  

 [[Recipient's First Name]]  

 [[Recipient's Last Name]]  

 [[Presentation Start]]  

 [[Presentation Duration]]  

 [[Contribution ID]] 
 
 

Active In Indico To be added 

Yes No Yes 
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Editor/Proceedings Administration > Email > SPMS Roles 

 
Email utility which allows to send emails to people with roles in SPMS 

 Conference coordinator 

 Database Administrator 

 Programme Committee 

 Various experts 
Substitutable fields can be used 

 [[Chair's Email]]  

 [[Editor's Email]]  

 [[Login URL]]  

 [[Search URL]]  

 [[Recipient's Name]]  

 [[Recipient's First Name]]  

 [[Recipient's Last Name]] 
 

Active In Indico To be added 

Yes No Yes 

   

 



64 | P a g e  
 

Editor/Proceedings Administration > Email > Session Chairs 

 
Email utility which allows to send emails to session chairs 
Substitutable fields can be used 

 [[Chair's Email]]  

 [[Editor's Email]]  

 [[Login URL]]  

 [[Publications URL]]  

 [[Search URL]]  

 [[Session Date]]  

 [[Session End Time]]  

 [[Session End Time - 30]]  

 [[Session ID]]  

 [[Session Location]]  

 [[Session Start Time]]  

 [[Session Start Time - 30]]  

 [[Session Title]]  

 [[Recipient's Name]]  

 [[Recipient's First Name]]  
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 [[Recipient's Last Name]] 

Active In Indico To be added 

Yes No Yes 

   

 

Editor/Proceedings Administration > File Types 

 
Page defining the list of file type authorised for submission by the contribution authors with parameters: 

 Reg Exp: regular expression used to assess whether the submitted file has correct naming and 
extension 

 Error Msg: displayed when the uploaded file name does not match regular expression 

 Required: file must be uploaded 

 Transparency flag: indicates if the file is used as support for an oral (it can be uploaded regardless 
of editing status, where file uploads are blocked) 

 Upload 2nd Codes – available for multiple programme code 
 

Active In Indico To be added 

Yes No Yes 

   

 

Editor/Proceedings Administration > Keyword Codes 

 
Page defining a list of keywords used by post-processing scripts 
 

Active In Indico To be added 

No No No 
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Editor/Proceedings Administration > List My Papers 

 
Page listing the papers assigned to the logged in user as an editor. Offers various options 

 Change editor status 

 View detailed contribution 

 Edit contribution 

 Show full log 

 Email authors 

 Upload and download files 
 
 

Active In Indico To be added 

Yes Yes Yes 

 “Paper Reviewing” -> “Layout Reviewer 
Area” 

The list of assigned papers could be 
improved to give access to more options as 
in SPMS 
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Editor/Proceedings Administration > List My Contributions 

 
Gives access to the list of contributions I own  
 
 

Active In Indico To be added 

Yes Yes No 

 “My Conference”->”My Contributions”  
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Editor/Proceedings Administration > Paper Error Codes 

 
Gives access to the list of error codes editors can use while processing papers. New ones can be added. 
 

Active In Indico To be added 

Yes No Yes 

  This can be implemented using the questions 
defined during the review setup, but we must 
add yes/no questions. 
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Editor/Proceedings Administration > Paper Final QA 

 
Can select a paper in the list of papers pending final QA classified by day in order to perform final QA over it 
 

Active In Indico To be added 

Yes Yes No 

 Final QA in Indico is done by the paper 
referee. 

 

 

Editor/Proceedings Administration > Platform Codes 

 
Displays the list of platform codes on which paper masters have originally be created defined for the 
conference. New ones can be added as well. 
 

Active In Indico To be added 

Yes No Yes 
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Editor/Proceedings Administration > Poster Police 

 
Gives the list of posters for each poster session and allows setting various “poster police” flags: 

 Was the poster manned? 

 Was the poster posted? 
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 Was the poster satisfactory? (Is the poster a real poster and not a replica of a paper) 

 Was a picture of the poster taken? 

 Comments 
 

Active In Indico To be added 

Yes No Yes 

  Should be implemented using a generic 
review system 

 

Editor/Proceedings Administration > Presentation File Combination 

 
Defines for each combination presentation type/File type 

 The weight of the uploaded file 

 If the file type can be uploaded exclusively by the editor 

 If the file type is always available: used to specify if the file type can always be uploaded regardless 
of the contribution status. 

 

Active In Indico To be added 

Yes No Yes 

  Will be simplified 
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Editor/Proceedings Administration > Presentations Management > Agenda 

 
Displays the conference timetable, either 

 Full 

 By Location 

 By Day 

 By Session 
 

Active In Indico To be added 

Yes Yes No 

   



73 | P a g e  
 

 

Editor/Proceedings Administration > Presentations Management > Transparency List 

 
Lists all papers indicating for each if slides have been uploaded. Gives access to the slides and upload and 
email options. This screen is used by the Presentations Managers. They can see whether the talks have been 
uploaded or not and contact the speakers via SPMS directly. 
 

Active In Indico To be added 

Yes No Yes 

  Allow to display for each contribution the 
number of files of each type 
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Editor/Proceedings Administration > Presentations Management > Transparency Processing 

 
This is the screen which shows the status of the processing by the editor processing the transparencies of 
the talks. 
 

Active In Indico To be added 

Yes No Yes 

  Transparency processing will be 
implemented using the generic review 
workflow 
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Editor/Proceedings Administration > Presentations Management > Transparency Status 

Maintenance 

 
Defines the various statuses used by the transparency processing workflow, as well as the texts of the mails 
which go to the speakers once the transparency processing is complete. 
 

Active In Indico To be added 

Yes No Yes 
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Editor/Proceedings Administration > Processing Status Code 

 
Defines the various statuses used by the paper editing/processing workflow, with various parameters: 

 Sort order 

 Email Msg: text of the email message sent to the abstract owner when the status is assigned 

 Image URL: URL to gif for colored dot 

 Ok to Upload: Yes if the author can upload a file 

 Send Email Notice: Yes if an email should be sent when the status is assigned 

 Publishable: Yes if the paper is publishable when the status is assigned 

 Edot board parameters: 
o Edot Board Text: text displayed on the board 
o Px Width and Px Height: width and height of the image on the board 
o Edot Fg and Bg colors: colors for Foreground and background of board cell 

 Ok to edit: Yes if the author can edit the contribution when it has this status assigned 

 User Validate: Yes if the author must validate the changes made to the paper when the status is 
assigned (after the editor has changed the paper for ex.) 

 User validate status: Status that the paper will fall back to if the author approves the changes made 
by the editor in the paper 

 PDF required: Yes if the editor cannot assign the status without a PDF be uploaded 
 

Active In Indico To be added 

Yes Partly Yes 

 Current layout review statuses in Indico 
are the same as content review statuses: 

 Accept 

 Reject 

 To be corrected 

 Layout review statuses should be 
different from content review 
statuses 

 Allow more parameters to statuses 

 Allow new statuses to be added 

 Allow to tailor email messages sent 
to authors 

 Add colored dot  

 Edot board configuration 
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 Ok to upload 

 Ok to edit 

 User validation needed 

 PDF required 

 

Editor/Proceedings Administration > Reassign Red Dot Papers 

 
This page lists all papers with red dot status and allows to re-assign the papers to a new editor. 
This is mostly used at the end of the conference when all of the “guest editors” disappear back to their 
home laboratories. The Editor-in-Chief normally takes over all of the remaining red dot status contributions 
so he can wee when new files are uploaded and deal with them so as not to bother the “original” editor. 
 

Active In Indico To be added 

Yes No Yes 

   

 

General 

General > Statistics 

 
General statistics page on the editing process. Includes 
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 Pie chart on contributions status (Assignable, No files, Unassigned, Assigned) 

 Pie chart on editor status (red, yellow, green, no editor) 

 Pie chart on FinalQA (failed, passed, publishable, remaining) 

 Pie chart on initial assignment (red, yellow, green) 

 Table with unassigned papers by platform and file type 

 Table with Activity log occurences 

 Table with Error code occurences (Pct and running columns); 
 

Active In Indico To be added 

Yes No Yes 

   

 

General > Data Extracts 
 

Various extraction features 

 AIP extract: HTML list of abstract/paper title and their associated authors.  

 
 Abstract book: HTML table of abstracts with ID, Paper ID, Title, presentation Type, classification, 

wuthors, speaker affiliation, abstract content, footnote and agency  

 
 Abstracts by time: HTML table of abstracts with date and time, Paper ID, title and speaker  
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 Affiliations Mailing List (Excel): Excel list of every affiliation represented at the conference with 
abbreviation, Name1, Name 2, Department, Type, Address 1, Address 2 Address 3, PO Box, Town, 
Postal Code, Zip code, country abbreviation, country name, Region and URL  

 
 All Orals: Excel list of all oral papers with Abstract ID, Paper ID, First name, Last name, Affiliation, 

Speaker Email, Mail Stop, Address 1, Address 2, Address 3, PO Box, Town, Postal Code, Zip Code, 
Country Code, Type, Title, Abstract, Main Classification, Sub Classification, Date, Time, Duration, 
Priority, Coordinator, Coordinator Email  
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 Author index: HTML list of authors for a conference and the IDs of the papers for which they're 
primary author or co-author  

 
 Conference Guide: HTML list of paper IDs, contribution titles, and author lists  

 
 Library Data > BibTex / CERN OAI / SPIRES / SPIRES Part 2: text data export of all conference papers 

metadata in formats for BibTex, CERN OAI, and SPIRES  
 

 Overview of Oral Presentations: tab-separated export list of all oral presentations showing paper 
ID, presentation title, and speaker names 
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 Post Conference XML: XML export of data that is used to generate the proceedings 

 
 
 

 Withdrawn Abstracts: HTML or CSV list of withdrawn abstracts with withdrawn date, withdrawn by, 
creation date, abstract ID, Paper ID, Title and authors 
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 Via Mailing List: Excel list of all profiles pertaining to a conference mailing list 

 

 Session Export: Excel list of session chairs, their email, affiliation, and address, as well as the list of 
speakers for each session, whether the talk is invited or contributed, and the classification/sub-
classification for the session 
 

 
 
 

Active In Indico To be added 

Yes No Yes 

   Evaluate which extracts should be kept 
Propose each extract in various formats: 
HTML, CSV 

 

General > Reports 
 

 Abstracts per day: graphical report on number of items affected each day by a given activity (to be 
chosen between Abstract created, Abstract initial QA performed, Abstract owner changed, Abstract 
updated, Abstract withdrawn, Author rejected the editor's changes, Copyright form received, Dot 
reassignment, Edit complete, File removed, File uploaded, Final QA failed, Final QA passed, Paper 
assigned, Paper copy received, Paper reassigned, Poster police, Referee, Transparency assigned  
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 Activity Log – Staff: paper-processing statistics for all of the editorial staff working at a conference 

Same as in Editor/Proceedings Administration 

 All Orals: generates in either HTML or CSV format, a table with conference data for all contributed 
and invited orals: 

o Paper ID 
o Type (invited or contributed) 
o Title 
o Speaker 
o Speaker's affiliation 
Same as in Programme Committee 

 Author Count: counts number of authors for the conference 

 
 Conference Activity charts: shows charts for all these activities on the same page: 

o Abstract created 
o Abstract created running total 
o Abstract updated 
o Abstract updated running total 
o Dot reassignment 
o Dot reassignment running total 
o Edit complete 
o Edit complete running total 
o File uploaded 
o File uploaded running total 
o Transparency assigned 
o Transparency assigned running total 
o Transparency complete 
o Transparency complete running total 
o Transparency reassigned 
o Transparency reassigned running total 
o Delegate registration 
o Delegate registration running total 
o Industrial Exhibition Registration 
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o Industrial Exhibition Registration running total 
o Student grant application 
o Student grant application running total 
o Student poster session 
o Student poster session running total 

 
 Conference Program: generates all of the information generally used to produce the conference 

program guide, such as 
o Paper ID 
o Authors 
o Title 
o Session 

 Contribution Counts > Affiliation: number and percentages of contributions according to affiliation 
of primary author 
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 Contribution Counts > Classifications – All: number and percentages of contributions according to 

classifications for all contributions 

 
 Contribution Counts > Classifications - By Presentation: number and percentages of contributions 

according to classifications for invited orals only 

 Contribution Counts > Classifications - Orals: number and percentages of contributions according to 
classifications for contributed orals only 

 Contribution Counts > Classifications - Posters: number and percentages of contributions according 
to classifications for posters only 

 Contribution Counts > Classifications – Poster Session Assignment: 

 Contribution Counts > Classifications – Presentation Summary: number and percentages of 
contributions according to classifications for all contributions split by types 

 
 Contribution Counts > Country: number and percentages of contributions according to affiliation of 

primary author split by presentation type 
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 Contribution Counts > Page Counts by Presentation: number of contributions according to number 

of page counts, split by presentation type and including max pages 

 
 Contribution Counts > By Region: number and percentage of contributions according to region of 

primary author split by presentation type 
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 Contribution Counts > Subclassifications – All: number and percentage of contributions according 

to subclassifications, for all contributions 

 
 Disjointed Authors: list the authors that are scheduled to present more than one oral presentation 

or (as is usually the case) more than one poster and who will need to have their presentation(s) 
times manually moved to other sessions; by day 
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 Duplicate Abstract Titles: lists any duplicate titles in the system, which could be duplicate 

contributions 

 
 Electronic Dot Board: the electronic dot board displayed on a big screen in the conference hall and 

which indicates to paper authors the editor status of their paper 
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 Green Dot Reports > Author Dot Reassignment: list of papers for which the authors have accepted 

the changes made by the editor 

 
 Green Dot Reports > Green Dot QA: list of papers with green dot but with no final QA passed 

 Green Dot Reports > Green Dot CF: list of papers with green dot but with no copyright form 
received 

 Green Dot Reports > Green Dot no paper: list of papers with green dot but with no paper copy 
received 
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 Hardcopy w/o File: list contributions for which a paper copy has been received but no electronic 
files have been received (this is deprecated) 

 Initial QA by presentation type: displays by presentation generic type (usually oral or poster) and 
classification the number of contributions and the number that have been QA'd 

 
 Invitees List: allows to enter the names of invitees to invitation-only conferences 

Same as in Overall Database Administration 

 List of Participants: provides a list of registered attendees at a conference, including their 
affiliations 

 
 No Dot Papers: shows a list of all contributions for which papers have been submitted but not yet 

assigned a dot 
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 Paper Count by Platform / File Type: shows number of contribution by platform, file type, and 

whether or not they have been assigned to an editor 

 
 Police Ok – No File: lists any posters that were presented (and that were deemed acceptable by the 

poster police) but for which no papers have been submitted 

 Poster Counts by Date: lists the number of posters slated for presentation for each day of the 
conference 
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 Proposed Presentation Changes: generates an Excel file with all proposed presentation type 

changes (usually made by the Scientific Programme Committee); includes fields, ID, Abstract Title, 
Classification, Original, Owner Lname, Owner Fname, Owner Affil, Owner Affil Name, Primary 
Author Lname, Primary Author Fname, Primary Author Affil, Primary Author Affil Name, Proposed, 
Proposed Count, Proposer Lname, Proposer Fname, Proposer Affil, Proposer Affil Name 

 
 QA comment w/o PDF: provides the full logs for all papers where a comment was made in the QA 

field but for which a new PDF file wasn't uploaded during the QA process 

 
 Referee > By Paper ID: List all papers with a link to the editing option page 
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 Referee > By Person: List all referees 

 
 Referee > Dot Status: shows dots assigned in the refereeing process today, or any time 

 Referee > Unassigned: lists all papers which have not been assigned to a referee 

 
 Registration by Abstract: generates a list of all registered delegates based on the program order 

(i.e., Monday, Tuesday) 

 
 Session Counts: generates a list of sessions organized chronologically (i.e., Monday, Tuesday) 

For each displays the number of contributions split by classification 
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 Session: generates a list of sessions showing the title, classification, date, time, location, 
presentation title, and speaker and affiliation 

 
 Table of Contents: generates a preliminary version of the proceedings based on what information is 

available. This URL is often distributed near the end of the conference or whenever all the papers 
have been processed. It is not the same as the final proceedings published on JACoW, which 
include headers, footers, searchable text, photos, etc. 
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 Unregistered Papers: generates a list of papers that have been submitted (and processed in most 

cases) but for which none of the authors have registered for the conference. Most often such 
papers are for posters. 

 
 
 

Active In Indico To be added 

Yes No Yes 

Hardcopy w/o File is 
deprecated 

 Evaluate which reports should be kept 
Propose each extract in various formats: 
HTML, CSV 
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Registration 

Registration > Setup & Maintenance > Bypass Name/Value Pairs 

 
This page allows the maintenance of a mapping table for an external registration system 
For details: http://www.jacow.org/index.php?n=Editors.ExternalRegistrationSetup  
 

Active In Indico To be added 

Yes Partly Yes 

   

 

http://www.jacow.org/index.php?n=Editors.ExternalRegistrationSetup
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Registration > Setup & Maintenance > Define Field 

 
Figure 1 Define new Field 

Define all fields in a field group. From this page one can 

 Select a field group in order to list existing fields in this group 

 Create a new field 

 Define a fee matrix 

 Define new registration types 

 Define new field groups 
In the field group data field list page one can see all fields attributes and get access to 

 Edit field 

 Delete Field (only if it is not used in a registration) 
 

Active In Indico To be added 
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Yes Yes No 

   

 

Registration > Setup & Maintenance > Define Field > Define New Field 

 
Figure 2 Define new Field 

The Define New field page includes fields:  
 Prompt - the question that will be presented to the visitor, like "Will you attend the banquet?" 

 Short Description - the label that will be used in XL reports 

 Group - fields group 

 Data Type: 
o Date - only valid dates can be entered by the user (When will you arrive?) 
o Fee - a number that will be used to calculate the amount the user will have to pay (Will 

you participate in the banquet? [20 EUR]) 
o Fee/Mult - a given fee multiplied by a number, like How many additional tickets for the 

banquet? (25 EUR each) 
o Number - a simple number, no letters allowed 
o Sponsorship - particular field for a list of attendees "sponsored" by a company (that won't 

need to pay for their fee) 
o String - a simple text (possibly multiline) 

 Display - how the field should be displayed: 
o Checkboxes - A list of check boxes (with a related fee if such a field type is selected) 
o Multi input text - only used for the sponsorship data type 
o Multi-line text - simple multiline text box 
o Pop up - A pop-up menu 
o Text Box - A single line box to enter free text 
o Yes/No 

 Fee - The fee amount (early fee) 

 Late Fee - The late fee (fee applied after a given date, usually higher than the early fee)* Late fee 
cutoff date - Date for selection early/late fee 

 Max Len - maximum length (number of characters) allowed to be entered 

 View Len - maximum display length in characters 

 Encrypt - Encrypt the users' data within the database. 

 Freeze - Prevents users from changing their registration once processing is complete 
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 Single - Restrict selection to the first registrant to select an item (e.g., for exhibition booths!). Note 
that for this option to work properly, the field must be a checkbox and Freeze should also be 
selected. 

 Required - Determines whether or not data for this field is mandatory 

 Fixed Len - Determines whether or not a fixed length is required for the entered text 

Active In Indico To be added 

Yes Partly Yes 

Sponsorship – is not used - It was to mark the 
delegate as “paid by” (sponsored) an industrial 
exhibitor. Needs a new procedure, did not work 
in practice. 

 - Late fees 

 

Registration > Setup & Maintenance > Fee Matrix 

 

 
This page allows to define fees based on the combination of two fee popup fields 
 

Active In Indico To be added 

Yes No No 
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Registration > Setup & Maintenance > Field Groups 

 
This page lists the existing field groups (usually a group of fields used in a given registration) 
 

Active In Indico To be added 

Yes No No 

   

 

Registration > Setup & Maintenance > Import Registration Form Data 

 
This page allows to copy all registration form data from a previous conference 
 

Active In Indico To be added 

Yes No Maybe (cloning may be enough) 

   

 



101 | P a g e  
 

Registration > Setup & Maintenance > Page Layout 

 
This page lists all existing registration forms with various parameters: 

 Name 

 List of available payments types 

 Whether the page is available to users or not (switch) 

 Whether a login is required or not (switch) 

 Whether admin priviledges are required to view data (switch) 

 Whether the registration is displayed as a link on the user profile pages (switch) 

 Whether the registration is displayed as a link on the contribution pages (switch) 
From this list you can also, for each registration: 

 Edit its general data 

 Edit its form 

 Delete it 

 Add/Remove payment type 

 Switch the above listed flags (switch) 
 

Active In Indico To be added 

Yes No Yes 

  - Allow individual selection of payment 
methods for each registration process 
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Registration > Setup & Maintenance > Page Layout > Edit Registration 

 
This page allows to modify the general attributes of a registration 

 Page Name 

 Admin’s email: email address to which all related emails will be sent (blank means conference 
admin) 

 Max registrants 

 Completion Text: text displayed upon registration completion 

 Return URL: that is where the user will be redirected when the registration is complete 

 External CC (credit card) Vendor URL 

 External Registration URL  

 Hide Receipt: When the registration does not need a receipt 

 Include registrants on List of Participants Report 

 Include Registrants on statistical Reports 
 

Active In Indico To be added 

Yes No Yes 

  - Completion text 

 

Registration > Setup & Maintenance > Page Layout > Associate / Modify Available Payments 

 
This page allows to associate existing payment methods to a registration 
 

Active In Indico To be added 

Yes No No 
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Registration > Setup & Maintenance > Payment Types 

 
This page lists the available payment methods and allows to edit or delete existing methods and create new 
ones. 
Payment methods have the following parameters: 

 Code 

 Description (name) 

 Online Option: Can users select this option? 

 Conf Option: Can registration staff select this option? 

 Credit Card: Is the method using credit card payment 

 Instructions: text displayed during registration payment process when the option is selected 

 Email Delay: Number of days to wait before sending email reminders to send in payment 

 Email Message 

 Percentage cost: percentage added to the final invoice price if the payment method is selected 

 Operation cost: fixed fee added to the final invoice if the payment method is selected 

 Waived: indicates if the payment method is used to waive some payments 
 

Active In Indico To be added 

Yes No Yes 

  - Waiving payments 
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Registration > Setup & Maintenance > Payment Vendor Variables 

 
This page lists all the hidden variables that are passed to the payment vendor by SPMS 
 

Active In Indico To be added 

Yes No Yes 

 This will be defined individually in each 
payment plugin 

- Generic payment plugin 

 

Registration > Setup & Maintenance > Payment Vendors 

 
This page lists all the payment vendors defined for the conference 
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Active In Indico To be added 

Yes No No 

   

 

Registration > Visa Invitation Letters 

 
Lists all the people that asked for a VISA request letter. 
 

Active In Indico To be added 

No No No 

   

 

Registration > Email 
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This page allows to send emails to registrants selected through some filtering criteria: 

 Registration page 

 Payment  Type 

 Balance Type 
The email body can be configured to use substitution variables: 

 Balance Due 

 Conference Name 

 Editor’s Email 

 Login URL 

 Name, First 

 Name, Last 

 Name, Middle 

 Name, Initials 
 

Active In Indico To be added 

Yes Partly Yes 

   

 

Registration > Payments and Invoices > Search and Process Attendees 

 

 
This page allows to search multiple attendees by 

 Registration type 

 Last name 

 Affiliation 
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 Checked/in status 

 Balance Due flag 

 Sponsored flag 

 From and To 
One can also browse attendees by name initial; In this case all attendees from any registration type are 
listed. 
The results list includes fields 

 Checked in 

 Name 

 Affiliation 

 Registration type 

 Sponsored By 

 Sponsorship type 
And links to perform the following actions 

 Show attendee Profile 

 Process registration 

 Check in attendee 

 Add Note 

 Edit Receipt 

 Edit Registration 

 Delete 

 Export the result list to an Excel file according to a template defined in “Export Templates” 
 

Active In Indico To be added 

Yes Partly Yes 

   

 

Registration > Payments and Invoices > Search and Process Attendees > Process Registration 

 
The process registration page shows details on due fees and payment made, and allows the following 
actions: 

 Add a miscellaneous fee 

 Add an Extra Payment/Refund 

 Save an extra payment  

 R: reassignment of a partial payment to another invoice item 
 

Active In Indico To be added 
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Yes Partly Yes 

   

 

Registration > Payments and Invoices > Search and Process Attendees > Receipt Edition 
 

 
The receipt edition page lists due sums and payments and balance due, and displays information on 
payment methods. It also allows to register a new payment. 
 
 

Active In Indico To be added 

Yes Partly Yes 

   

 

Registration > Payment & Invoices > Export Templates 
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This page lists the existing export templates, and allows to create new ones and edit or delete existing ones. 
Export templates are used in the Attendees Search results page. 
Templates can include fields: 

 Last Name 

 First Name 

 Checked In 

 Affialiation 

 Registration type 

 Registration date 

 Sponsored by 

 Sponsorship type 

 Fee 

 Paid 

 Due 
 
 

Active In Indico To be added 

Yes Partly Yes 

   

 

Registration > Payment & Invoices > Send Notice to Unpaid Registrants 
 

 
 Send an email to all registrants who have not yet paid the registration. Either only to those who 

have not yet received such an email, or to all of them. 
 

Active In Indico To be added 

Yes No No 
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Registration > Payment & Invoices > Record a Payment (Slow - Not Recommended) 

 
Lists all registrants with unpaid balances with amount due and name and gives access for each to 

 Process registration screen 

 User Profile 

 Edit registration page 

 Receipt edition page (Invoice) 
 

Active In Indico To be added 

Yes No No 
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Registration > Payment & Invoices > Bulk Registration From External Source 

 
 Bulk insert several registrants from an external registration system 

 

Active In Indico To be added 

Yes No No 
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Registration > Registration Reports > Budget Report 

 
Budget Report of the various registrations and grand totals 
 

Active In Indico To be added 

Yes No Yes 
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Registration > Registration Reports > Country / Region Stats 

 
Statistics of origin (country/region) for each registration and overall 
 

Active In Indico To be added 

Yes No Yes 
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Registration > Registration Reports > Data Extract (Excel) 

 
Exports data to Excel from one selected registration form. Option to select only registrants with a dued 
balance 
 

Active In Indico To be added 

Yes No No 

   

 

Registration > Registration Reports > List All Attendees 

 
Lists all attendees 
 

Active In Indico To be added 

Yes No Yes 
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Registration > Registration Reports > Paying Summary (Items) 

 
Lists all fee items and the number of times they were selected in registrations 
 

Active In Indico To be added 

Yes No Yes 

   

 

Registration > Registration Reports > Print All Invoices 
 

Prints All Invoices 
 

Active In Indico To be added 

Yes No Yes 

   

 

Registration > Registration Reports > Registration By Abstract 
 

Same As in Reports 

Active In Indico To be added 

Yes No Yes 
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Registration > Registration Reports > Statistics 

 
Displays statistics by registration or by selected fields and popups 
 

Active In Indico To be added 

Yes No No 

   

 

Registration > Registration Reports > Summary Statistics 

 
Displays general stats on registrations 

Active In Indico To be added 

Yes No Yes 

   

 

Registration > Registration Reports > Vendor Delegate List 
 

Lists all delegates from Vendors based on the “sponsored” type 

Active In Indico To be added 

No No No – better system needs to be envisaged  
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Architecture of the Future JACoW/Indico Service 
 User profile modifications will be done directly on the JACoW 

central repo, never on Indico. Central modifications will be 

synchronised with Indico at the next user login, as well as at 

regular times to ensure global synchronisation. [8] 

List of Features to be implemented in Indico 

General Features 
 Let people with different roles select the role which will be used to display their interface [8] 

[P:medium] 

 Define local groups of people inside the conference which have no direct functional role in 

Indico; these groups can then be assigned specific rights; Not only is this important to keep 

track of the composition of the groups in past conferences, but this facilitates also the 

assignment of privileges and email sending [3] [P:high] 

o Propose default groups: “Organising Committee”, “Local Organising Committee”, 

“Programme Committee”, “Advisory Board” 

o Allow the creation of additional ones 

o Allow to select local groups when adding people to a role 

o Display list of members for a group in order be able to copy paste in an html page 

o Export multiple groups as csv in order to use MS Word mail merge feature 

 Create a page which lists all the conference roles with their members (see Authorize) [2] 

[P:high] 

 Missing Roles [P:high] 

o Generic roles [2]: 

 Abstract manager 

 Registration manager 

 Paper review manager 

 Scientific programme manager: can modify the timetable, and manage 

sessions 

o Other roles: 

 Abstract Curators: performs initial abstract Q/A 

 In Indico, abstract curator will be the abstract manager 

 Final Paper Curators: performs final paper Q/A 

 In Indico these are the referees 

 Poster Session Manager: performs the poster police 

 Will be implemented through the generic review process 

 Presentation Manager: performs the transparency processing tasks 

 Will be implemented through the generic review process 

 Missing privileges: [1] [P:low] 

o View Registrations 

o Registration Operator (restricted permissions for ex. on-site registration 

hostess/steward) 

o View Scientific Programmes Reports 

 Classifications (see Main Classifications): [4] [P:high] 

o Sub-classifications: allows to create sub-tracks below each defined track in the 

programme 

Resource needs appear between brackets in 
the rest of the document and are expressed 

in number of weeks except when specified 
otherwise. 

Priorities defined by the JACoW team appear 
between brackets starting with a “P” 
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 An option lets users select sub-tracks when submitting an abstract, or 

reserve this to the conference administrators. 

 Sub tracks then appear anywhere tracks were used 

o Import/export mechanism for classifications 

 Provided by the Indico clone feature 

 Define Rooms for event (see Location Codes) [6] [P:high] 

o Each room has a room code (may be used for the program code generation) 

o Each room has a name and description 

o Each room has a poster capacity (used for automated poster assignment) 

o The defined rooms are then proposed as an alternative to the free text field; this 

ensures homogeneity in the room denomination and adds up the capacity feature  

 The mobile version of the website could be improved, see as example [P:low] 

o http://app2.core-apps.com/ipac15  

Email Management [P:medium] 
 Keep log of all emails sent by the system for one specific event [2] 

 Page to send emails to various people based on their roles (see SPMS Roles for details): [2] 

o Select recipients from existing lists / roles (participants, referees, reviewers etc.) 

o Compose email with substitutable tags 

 Page to send emails to session chairs (see Session Chairs for details) [1.9.7] 

o Select recipients by session 

o Compose email with substitutable tags 

 Page to send emails to registrants [3] [P:high] 

o Select recipients by registration page 

o Select recipients by payment method 

o Select recipients by payment status 

 Queue email sending in task manager to avoid overload (hundreds of emails can be sent by 

one single action) [3] 

 Add general option to cc all emails sent by Indico for the event to the administrators. [1] 

 For each generic email utility, indicate the number of addressees before actually sending the 

email. [1] [P:high] 

Abstract Management 
 Types of contributions: Add the following parameters (see Presentation Types 

(Contributions)) [1] [P:high] 

o Presentation Code (for use in program code generation) 

o Poster/Oral option 

o Max pages for final paper 

o One flag to indicate if the type can only be assigned by editors/PC 

o One flag to indicate if a contribution of this type can be reassigned by the PC 

o One flag to indicate if the code should be used in the program code 

o One flag to indicate if the type can be proposed as an invited oral 

o Sort order 

 Create Session Types (see Presentation Types (Sessions)) [P:medium] 

o Each session type includes code, description, type (oral/poster) 

o Each session block should be assigned a presentation type 

o The code of the type is then used to generate session codes 

http://app2.core-apps.com/ipac15
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o This adds too much extra complexity to the software without bringing much value, 

session base codes will be entered manually. 

 Add abstract owner “Owner” (in addition to “submitter”) [1] [P:high] 

 Add abstract attributes: attributes that can be set only by abstract managers and can be 

viewed only by abstract managers (for ex. Invited Oral Pending, Invited Oral Accepted, 

Invited Oral Declined) (see Abstract Attributes) [2] 

 Initial Q/A Process (see QA): [P:high] 

o Once an abstract is submitted, the scientific secretariat checks its format, performs 

adequate changes and records the initial Q/A done, before it is handed over to the 

SPC 

o Initial Q/A done is indicated by a flag available in the detailed abstract page and in 

the abstract list, visible and set only by scientific secretariat and conference admins 

o If the abstract owner modifies the abstract after the initial QA is performed, the QA 

status is reinitialised. 

o This will be implemented by means of abstract attributes: the scientific secretary 

will receive emails when an abstract is modified as a warning to perform the Q/A 

again. 

 Abstract creation/edit forms [2] (see Edit) 

o Add TitleCase feature to title field (automated upper casing of words in the title) 

 Added as a plugin 

 Detailed abstract page [1] [P:medium] 

o Add full abstract history only available to managers (authorisations maybe defined 

elsewhere) 

o Add generic author emailing feature which allows to send mails to either Primary 

author, authors, speakers (and copy admins) and define the subject and body of the 

email with substitutable fields (see Email for details) 

 Participation confirmation [2] [P:medium] 

o Optional process 

o When an abstract is accepted, an email is sent to the owner announcing the 

acceptance and requiring confirmation of the participation to the conference (a URL 

is generated to allow the owner to accept or decline participation to the conference) 

o A “Confirm participation” button is also added to the detailed abstract page 

 Book of Abstract: Allows to display authors Initials only [1] [P:medium] 

 Abstract selection: [P:high] 

o Rename track reviewers into track experts 

o Implement the abstract manager role which can [1] 

 nominate track coordinators and track experts 

 change presentation types 

 reclassify abstracts 

 Have access to the list of abstracts with average ratings and spread 

o Allow track experts to propose a different presentation type (see Abstract 

Reclassification) [1] 

o Track coordinators perform the reclassification and change of presentation type [1] 

o Allow sending instructions to track experts when they are nominated; define email 

content [1] 
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o The list of abstracts for track coordinators and administrators should have an easy 

option to change the classification and/or presentation types of selected abstracts 

[1] 

o Add a summary/statistics page for abstracts showing per track the number and 

percentage of each presentation types [1] 

 Invited Orals Workflow – Optional [6] [P:medium] 

o Before the call for abstract is opened, a new process handles invited orals 

o Authorised people (usually the SAB) can propose invited orals 

o PC members can then rate them 

 For this the abstract manager or admin defines priority levels (as many as 

desired) which are used to classify the invited proposals (see Proposed 

Invited Oral Priority Codes) 

o One page should list all proposed abstracts with their priorities and provide options 

for the IOM to 

 List all proposals without priorities and withdraw them 

o The Invited Orals Manager accepts/rejects proposals 

 On acceptance, the primary author is turned to owner 

 On rejection, the abstract is withdrawn 

o A mail is sent to proposed speaker to invite them to the conference, and ask them to 

update the abstract data 

 List of Abstracts/Contributions (see Abstract Search/Edit for details) [3] [P:high] 

o Many  filtering criteria should be added  

o Improve sorting options: 3 levels should be proposed 

o Add Funding agency to the results display options 

o Should allow to add to the display the number of files for each file type and 

sort/filter by number of files attached. 

o The results list should provide easy access to all contribution related features  

File Management [12] 
- Define platforms for the conference (platforms on which the paper master file has been 

generated, this helps assigning papers to editors working on the proper platform) (see 

Platform Codes) [P:high] 

o Propose default list: “Windows”, “Linux”, “OS X”, “UNIX” 

o Allow addition of other platforms 

- Create default file types (folder names) for the conference (see File Upload and File Types) 

[P:high] 

o Propose default list: “Paper Source File”, “Paper Printable file (PDF/PS)”, “Paper 

Images”, “Poster Printable File”, “Poster Master File”, “Slides” 

o Each file type will define 

 a checkbox that indicates whether the platform should be requested when 

uploading the file (typically only the source file needs to have the platform 

information) 

 a regular expression which defines which files will be accepted in this folder 

 an error message which will be sent to the user who tries to upload a wrong 

file type 

 a text field that will be displayed on the file upload dialog if the file type is 

selected (typical example is “Please read the JACoW Template Checklist 

document before uploading your manuscript”) 

http://jacow.web.psi.ch/authorInfo/checkList.html
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 a confirmation text which will be presented to the user when the file is 

uploaded if this type is selected (typical example would be “Please confirm 

that the document you are uploading validates the JACoW publishing 

guidelines”) 

 A folder will be associated to a review process when we create the generic 

review workflows (as the JACoW use case multiplies reviews: poster, paper, 

slides) 

o Let the admin create other default folders [P:high] 

o Let the admin decide whether users can create their own folders or can only use the 

default ones. [P:low] 

- Assign file types to contribution types 

o Only these file types will be proposed when uploading files to a given contribution 

o Create a matrix (see Presentation File Combination) which  

 assigns weights to each file type/contribution type. This weight is then used 

to compute the automated editor assignment threshold. 

 Indicates if only the layout reviewer can upload the given file type for the 

given contribution type. 

 This will not be implemented, instead a simpler scheme based on the 

number of files uploaded will be 

- File Upload dialog (see File Upload) [P:high] 

o Add types and platforms 

o Add comments which are only recorded in the logs 

o An option forces authors to verify the abstract metadata before they can upload the 

first file. This is to detect any discrepancies between the paper title, authors and 

summary and the abstract metadata. 

 This will not be implemented, as it is considered too specific 

o Pluggable configuration for external file checks (e.g., a web service that checks for 

embedded fonts in PDF, number of pages, re-distills the PS/PDF, etc.). These plugins 

should be role-based configuration (e.g., do not call fonts check for users, do call for 

editors…) 

 If the web service exists then a plugin can easily add a button on the 

editor’s interface to trigger the validation 

- Define Source File Types (see Editor Source File Types): these are basically regular 

expressions which allow to determine the type of the file which has been uploaded. These 

are used by layout reviewers when they want to be assigned a new paper. Default values 

include 

o Any Type => .*$ 

o LaTeX => .(TEX|LATEX)$ 

o MS Word => .(DOC|DOCX)|DOCM$ 

o OpenDocument Text => .(ODT)$ 

- All file versions are preserved and presented as download options to the users 

Session Management 
 Generate program codes automatically [4] [P:high] 

o Each contribution is assigned a program code manually or automatically. Program 

codes are generated by appending a sequential value (defined inside each session 

block) to a base program code (defined for each session block); currently Indico 

implements session codes, this should be transferred to session blocks. 

http://jacow.web.psi.ch/authorInfo/checkList.html
http://jacow.web.psi.ch/authorInfo/checkList.html
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o A general option defines the number of digits used in the program code generation 

for oral sessions and for poster sessions. (see Conference) 

o A general option defines whether session codes are assigned automatically or 

manually (see Conference) 

o Base program codes can be assigned to each session block either manually, or 

automatically computed as follows: 

 Short day of the week (MO, TU, …, SU) + session type + room code 

o It should be possible to re-assign program codes individually or by session block 

using a specific sorting algorithm. 

o The sorting algorithm is especially interesting for posters where you will try to group 

posters with the same presenter together or with similar topics. Also, posters having 

presenters from the same institute should be assigned “close” each other (“Village” 

system) to help with last minute needed substitutions of presenters. The sort order 

should at least include the following fields (see Program Code Sort Order): 

 Main classification 

 Sub-classification 

 Country of presenter 

 Town of presenter 

 Affiliation of presenter 

 Last name of presenter 

 First name of presenter 

o An option allows to keep program codes hidden until the programme is finalised 

o A paper withdrawn after being assigned a program code will for ex. result in a gap in 

the sequence number. Further papers should not be resequenced automatically 

without admin intervention in this case. Instead: 

o It should be possible to list paper ID sequences for all session blocks in order to 

easily see id gaps, and resequence papers if needed (a button is proposed for that 

purpose). 

 Allow presentation of abstract in different sessions (eg. poster, student poster, student 

poster oral) [2] [P:medium] 

o This will be implemented by cloning the original contribution and giving it the 

same parent abstract. 

 Create a page listing all session blocks with additional actions (see Sessions): [3] [P:high] 

o Generate automatically program codes for papers in each selected session 

o Add/remove chair 

o Delete session 

o Edit session 

o The page comprises the following fields: 

 Session code 

 Type 

 Date 

 Start time 

 End time 

 Title 

 Location 

 Chair 
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User search 
 Should return close matches (implemented using Oracle Text search plus in the SPMS): 

search for “baron” will return all users registered with name “baron”, but also, below and in 

a separate section, users with close names (bahrami, barin, barana, barno etc.) [4] 

[P:medium] 

o We will not develop this, so the resources assigned to this line are mostly for 

researching a library which would do this on PostgreSQL and adapt it to Indico. 

Paper Management 
- Add “Publishability” criteria to contributions  [P:high] 

o This flag determines whether a paper can be published in the proceedings or not 

o The flag is computed automatically from various constraints 

 Passing the editing process (final QA) 

 Passing the reviewing process 

 Passing the poster police process 

o We propose to implement this by letting the event manager filter out which 

contributions they want to export to the external proceedings generation engine 

(for ex. contributions which paper review has been accepted and which poster 

police has been positive). The development of generic reviews will allow to apply 

this not only to papers, but also to any kind of uploaded file (posters or 

transparencies for ex.) [1] 

- Add “Final QA” process [P:high] 

o This process allows a final check of the papers before they are sent to publication 

o Final QA can take place as soon as a green dot is assigned to a paper by its editor 

o QA editors are usually the same group of people as editors. 

o Add an option to forbid the assignment of a QA to the person who edited the paper. 

o Statuses for final QA are passed, failed, pending 

o Final QA page (see Final QA), from where the QA editor can 

 Manually get a new paper to Q/A (from the list of papers with green dots 

but w/o Q/A set) 

 For the paper being Q/Aed: 

 Change the contribution title (with titleCase option) 

 Choose an action: 

o QA complete 

o QA failed - Re-assign paper to me 

o QA failed – Re-assign paper to editor 

 Set actual page count 

 Add an optional comment (log only) 

 Download and Upload files 

o Add a “Select Paper QA page” where the editor in chief can self-assign a paper 

available by day (see Paper Final QA) 

o Indico equivalent: referee (the referee in Indico terms validates the review made 

by the layout and content reviewers) 

 All the editing team would be managers of the paper review and as such 

will be able to self-assign any paper they want. 

- Paper Upload: allow multiple file uploads: master format, PDF or PS, extracted image files 

[P:medium] 

- Review Process [P:high] 
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o Define a list of error codes that reviewers can use to justify their decisions. The 

codes can then be selected in the reviewers assessment page and on the poster 

police page; The list includes (see Paper Error Codes)  [2] 

 A code 

 A description 

 The equivalent in Indico is the questions defined for each review process 

 Would need to add Boolean flags to the questions 

o Review statuses 

 Layout and content reviews do not use the same statuses [2] 

 Statuses should include the following parameters (see Processing Status 

Code and Referee Status Codes) [3] 

 Sort order  

 Email body: body of the email which will be sent to the paper owner 

when the status is selected  

 Corresponding coloured dot 

 Ok to upload: if set to yes, allow the paper owner to upload files  

 Send Email Notice: send a mail to paper owner when the status is 

assigned  

 Publishable: Yes if the paper can be published when on this status 

 Ok to edit: Yes if the author can edit the contribution when on this 

status (only for layout review) 

 User validate: Yes if the author must validate the changes made to 

the paper when the status is assigned (after the editor has changed 

the paper for ex.) (only for layout review) 

o This would be handled in Indico using chat-like interactions 

between the editor and the author 

 User Validate Status: Status that will be assigned to the paper if the 

author approves the changes made by the editor (only for layout 

review) 

 PDF required: prevents an editor from assigning this status if a PDF 

file is not uploaded (only for layout review) 

 Default statuses should be proposed but can be modified and additional 

statuses can be created 

 Layout Review (see Processing Status Code): 

o Assigned (a reviewer is assigned the paper); purple dot 

o Accepted (the paper is ok as is or only very minor changes 

have been made by the editor which do not necessitate 

author checking); green dot 

o Corrected (the paper has been corrected by the editor, 

usually from source files, and the author must approve the 

corrections); yellow dot 

o To Be Corrected (the paper does not meet the quality 

criteria and the editor cannot edit it – the author should 

revise it taking into considerations the comments by the 

editor, and the error codes selected); red dot 

o Tailor all emails sent to layout reviewers [2]  

 Also be able to bcc others on all/some emails 
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o The assignment to layout reviewer (editor) of papers is possible when enough files 

have been received 

 This uses a “file upload threshold” and file type weights. If this value is lower 

than the addition of all weights assigned to a file type for which a file has 

been uploaded, then the paper can be assigned to an editor.   (see User and 

Presentation File Combination) 

 This mechanism gives flexibility on the assignment of papers to editors. This 

gives the possibility to the review manager to start with a high threshold in 

order to edit only papers for which master and PDF have been submitted, 

then lower the threshold to start editing papers with one file missing. 

 First approximation for Indico will be to propose papers which have a 

given number of files uploaded (that the review manager can configure in 

the module), without weight; and propose other sorting options (last 

modification date, date of submission etc.) [1] 

o Papers are not actually assigned automatically to editors without their intervention, 

but each editor can click a button “Get Next Paper” after setting some parameters 

(platform, source type – doc or latex mainly, or paper ID) which will assign to 

him/her the next editable paper. (see Editor / Proceedings Administration)  

 Implement a full screen view of an “editing pad” showing PDF in the 

browser as well as the chat-like interface for editor-author interactions 

and the reviewing questions/checklist [12] 

o Trigger validation by contribution owner of changes made by the layout reviewer if 

the status is set to yellow dot (see Accept/Reject Editors’ changes) 

 The validation page includes a dropdown menu showing I “Accept” or 

“Reject” the editor’s changes with a free text multi line comments box 

(recorded in the logs) that is mandatory  if the answer is Reject 

 If the change is accepted, the status of the paper is changed to the one 

defined in the status lists for this purpose. 

 If the change is rejected, the status does not change 

 Will be implemented as a chat-like interface between editor and author, 

with email gateway 

o General list of papers:[2] 

 Allow filtering on layout statuses 

 Allow filtering on type of uploaded files (PDF only for example) 

 Add final Q/A status and actions 

 Allow to hide data on one or the other review types 

 Add generic author emailing feature (see details Email Utility) which allows 

to send mails to either Primary author, authors, speakers (and copy admins) 

and  

 Filter the recipients by lots of different fields 

 define the subject and body of the email with substitutable fields 

o Detailed paper/contribution page [1] 

 Add for the review manager the possibility to set in one place 

 Layout review status 

 All Q/A flags 

o Personal list of papers assigned to layout reviewers (see List My Papers) [2] 

 Includes options to download and upload files directly 
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 Includes options to change the status of the paper directly from the list (with 

popup to add comments) 

 Shows full log 

 Email authors 

o A page allows to list all red dots (layout review) and assign a new editor to the 

selected ones (see Reassign Red Dot Papers) 

 From the Indico “Assigned Papers” page 

o E-Dot Board (see Reports) [2] 

 Full screen page showing statuses of each paper from the layout review 

perspective 

 Implemented as a standalone interface fetching data from Indico through 

the http api 

o Poster Session Management (Poster police): set of checks which are applied to 

posters and taken into account when deciding whether to publish the paper related 

to a poster or not. 

 People in charge have access to a page from where they can select a session 

block (see Poster Police); Selecting a session block gives access to a page 

displaying all posters in the session, with options to check some QA flags: 

 Check flags include  

 “Manned”: whether the poster is manned or not,  

 “Satisfactory”: the quality of the poster itself (is it just a copy-paste 

of the final paper?) 

 “Posted”: whether the poster file has been uploaded 

 “Picture”: store a picture of the poster to demonstrate an issue 

 The three poster Q/A flags must be positive for the paper to be publishable 

 This workflow will be implemented using the generic review interface 

o Presentation Management process (completely missing from Indico) 

 The presentation manager has multiple tasks: 

 Checking transparency files are uploaded 

 Transferring files to auditoria and checking they can be displayed 

correctly 

 Processing transparencies into pdf for publishing 

 For some conferences both the slides and the paper will be published. They 

have distinct publishability values. 

 Usually presenters are requested to submit a pdf of their transparencies for 

publication. This workflow allows editors to assess the PDF together with 

the author if needed. 

 Create a page to list all oral contributions with their attached slides; easy 

access to download and upload features (see Transparency List) 

 Create a page for the presentation managers (see Transparency Processing) 

which 

 For each day, shows stats on the status the transparency 

assessment for all contributions, for each category of oral 

contributions 

 Allow the self-assignment of a transparency after selecting it from a 

daily list 



127 | P a g e  
 

o Transparencies should only be edited after they have been 

presented – otherwise there is a risk that they are revised by 

the presenter even at the last minute before presentation 

 List all self-assigned active transparencies 

 List all self-assigned processed transparencies 

 Set status of assigned transparencies 

 Create a page to define presentation management statuses (see 

Transparency Status Maintenance) each with the following attributes: 

 Coloured dot 

 Email message that will be sent to the author when the status is 

assigned 

 Publishable: flag indicating if the transparency is publishable when 

the status is assigned 

 Default statuses: 

o Green: processing successful, slides can be published 

o Yellow: transparencies were edited in order to create the 

PDF. PDF must be checked by the author who should accept 

the changes 

o Red: transparencies cannot be processed. Author is required 

to read the editor’s comments and come to the author 

reception 

 This workflow will be implemented using the generic review interface 

o Implement a generic review process which will be used for paper, poster, 

transparencies etc. [12] 

Timetable Management 
- Add “My Schedule” option [P:low] [4] 

- Automated poster assignment into sessions (according to tracks/sub-tracks) (see Bulk 

Assignment) [P:high] [3] 

o Sessions are associated to tracks/subtracks 

o Posters are then assigned to sessions automatically according to this configuration 

and the capacity of each session. Only one button is used: “Assign” 

- Contribution detailed page [P:high] [1] 

o Preserve the full history of all changes performed to an abstract/contribution and 

display them in a log page 

 

Statistics and Report Pages [in days] 
- Exports (see Data Extracts) 

o AIP extract (HTML) {DN} [1] 

o Abstract book (HTML) {Y} [1] 

o Abstract by time (HTML) {Y} [1] 

o Affiliation list (Excel) {DN} [1] 

o All Orals (Excel) {Y} [1] 

o All Orals (tsv file) {DN} [1] 

o Author Index (HTML) {DN} [1] 

o Conference guide (HTML) {DN} [1] 
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o Conference paper export in bibTeX {Y} [2] 

o Conference paper export in CERN OAI {Y} [2] 

o Conference paper export in SPIRES format {Y} [2] 

o Post Conference XML (for JACoW proceedings) {Y} [2] 

o Withdrawn abstracts (HTML or csv) {Y} [1] 

o Session chairs (Excel) {Y} [1] 

o Disjointed Authors: list the authors that are scheduled to present more than one 

oral presentation or (as is usually the case) more than one poster and who will need 

to have their presentation(s) times manually moved to other sessions; by day {Y} [2] 

o List any duplicate titles in the system {Y} [1] 

o List all papers for which the author have accepted the changes made by the editor 

{Y} [1] 

o List all papers which have a green dot but no final QA passed {Y} [1] 

o List all papers with green dot but no copyright form {Y} [1] 

o List all papers with green dot but no paper copy received {N} 

o List all papers for which a paper copy has been received but no file {N} 

o List of papers with no dot {Y} [1] 

o List all posters with police ok but no file {Y} [1] 

o List of all contributions for which a presentation type change has been proposed 

(Excel) {Y} [1] 

o List of participants {Y} [1] 

o List of all contributions by program order, including for each the list of registered 

people (either authors or presenters) {Y} [1] 

o List all sessions and for each the number of contribution per classification {Y} [1] 

o List of papers without any attendance registered {Y} [1] 

- Reports (see Reports) 

o Abstracts per day {Y} [10] 

o Author count {Y} [1] 

o Conference Activity charts {Y} [10] 

o Contribution Counts per affiliations {Y} [2] 

o Contribution Counts per classification for all contributions {Y} [2] 

o Contribution counts per classification for orals only {Y} [2] 

o Contribution counts per classification for posters only {Y} [2] 

o Contribution counts per classification split per contribution type {DN} [2] 

o Contribution counts per country of presenter split by presentation type {Y} [2] 

o Number of pages per type of contribution {Y} [2] 

o Contribution counts per region of presenter split by presentation type {Y} [10] 

 Only possible outside Indico: no region defined in Indico 

o Contribution counts per subclassification {Y} [2] 

o Number of contributions with initial QA done and remaining by main classification  

{DN} [2] 

o Number of  files per platform and file type (assigned and unassigned) {Y} [1] 

o Number of posters presented by date  {Y} [1] 

- Reviews 

o Create a Statistics page for the layout review process (see details Statistics) {Y} [5] 

o Activity log for staff: a page showing for each person involved in the paper review 

process (see Activity Log - Staff) {Y} [5] 
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 The number of dots reassignment they performed (usually done only by the 

review manager to turn a yellow to a green for ex. when no feedback is 

received from the author, or when the feedback is received orally in the 

processing room directly) 

 The percentage of red, yellow and green dot they assigned initially 

 The number of papers they processed completely (to the green dot) 

 The number of papers you assigned a final QA failed status to (in general 

edited by other people)  

 The number of papers you assigned a final QA passed status to (in general 

edited by other people) 

 The number of QA failures the papers they edited got (+ percentage 

compared to the number of papers they processed) 

 The number of papers that the person has reassigned to his or her self 

 The number of transparencies that were 

 assigned to the person 

 completely assessed by the person 

 re-assigned to the person (by his or her self) 

Registration [P:high] 
 Allow export/import registration form feature 

o Cloning conference already provides this option 

 Allow each registration process to select which payment methods will be proposed to 

delegates [4] 

o Available to delegates 

o Available to admins 

 Add completion text to registration process definition [1] 

 Add profile data to registration data when the registration requires login 

o Already exists 

 Add Early registration deadline field 

o Fees may be different before and after the early registration deadline 

o Application to each field independently (dates as well) 

o We propose that early bird fees are set by changing manually the value of the fee 

after a given date. 

 Email utilities 

o Add email utility to contact delegates of a given registration process in function of 

their payment type of balance (see details Email)  

o Already exists 

 Add a registrant list feature common to all registration processes (see details Search and 

Process Attendees) [2] 

o Only listing of profiles 

 Add more flexibility when processing the payment of a registrant [10] 

o Possibility to mark payment of individual items  

 This is used when for example the conference fee is sponsored by the home 

institute by bank transfer while goodies or conference dinner are paid 

individually by the delegate. 

 We believe that this is adding a lot of complexity for very few cases, and 

know no other vendor which implement partial payments, so would rather 

drop this feature. 
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o Possibility to add misc fees (waived fees for ex) 

 E-payment plugins to create: 

o Cheques [1] 

 Payment by cheques 

o Waive [2] 

 Only for admins – allows waiving some payments 

 Register payment promises for payment methods that are not directly connected with Indico 

(cheques, bank transfers) [2] 

 Registration can be cancelled only when no payment has been made (or all payments have 

been refunded) 

o In Indico users need to contact the organisers to request cancellation 

 Reports 

o Create page summarising the financial status of the conference (see Budget Report) 

[2] 

o Summarize registrations by countries/regions (see Country / Region Stats)  

o Page which summarises how many paying items were selected in each registration 

process (see Paying Summary (Items))  

 Already there 

o General stats on registrations (see Summary Statistics) 

 Allow external registration systems to update Indico with registration status [5] 
o http://www.jacow.org/index.php?n=Editors.ExternalRegistrationSetup 

o PCO have their own registration system 

o Registrants go through Indico and are directly redirected to the PCO web site 

(passing hidden fields such as profile ID) 

o PCO pushes back the user ID to the registration form of Indico as soon as the process 

is complete so that the user is added to the Indico registrant list 

 Add an option to bulk import registrants from a list of profile IDs [2] 

 Publish receipts for completed registrations as an option [4] 

o An option to print all receipts in one go 

 Registration form:  

o Allow adding markdown (or an html subset with at least image, bold and hyperlink) 

to field descriptions [1] 

o Analyse usage of booth selection widget 

 

Summary and Resource Needs 
    high 

only 
all 

Setup of the Overall Architecture  8 high 8 8 

General Features    17 26 

 Role selection 8 medium   

 Local groups 3 high   

 Roles page 2 high   

 Missing roles 2 high   

 Missing privileges 1 low   

 Sub-classifications 4 high   

 Event rooms 6 high   

http://www.jacow.org/index.php?n=Editors.ExternalRegistrationSetup
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Email Management    4 12 

 Log all 2 medium   

 Email by role 2 medium   

 Email to registrants 3 high   

 Queue emails 3 medium   

 cc admins 1 medium   

 number of addressees 1 high   

Abstract Management    15 24 

 Contribution type 1 high   

 Abstract owner 1 high   

 Abstract attributes 2 high   

 TitleCase 2 low   

 Full abstract log 1 medium   

 Participation confirmation 2 medium   

 Abstract selection 6 high   

 Invited Orals 6 medium   

 List of abstracts 3 high   

File Management  12 high 12 12 

Session Management    7 9 

 Program codes 4 high   

 Multiple scheduled abstracts 2 medium   

 Session list 3 high   

User Search  4 medium  4 

Paper Management    40 40 

 Publishability as XML export filtering 
criteria 

1 high   

 Error codes/checklist 2 high   

 Review statuses 3 high   

 Email customization 2 high   

 File weight 1 high   

 Editing Pad 12 high   

 List of papers 2 high   

 Detailed paper 1 high   

 Editor's list of papers 2 high   

 E-Dot board 2 high   

 Generic Reviews 12 high   

Timetable    4 8 

 My schedule 4 low   

 Automated poster assignment 3 high   

 Contribution details 1 high   

Stats & Reports    6 18 

 Exports 6 high   

 Reports 12 medium   

Registration    36 36 

 

 Payment method by form 4 high   
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 Completion text 1 high   

 General registrants list 2 high   

 Payment flexibility 10 high   

 Payment methods 3 high   

 Payment promises 2 high   

 Reports 2 high   

 External registration connection 5 high   

 Bulk import 2 high   

 Receipts 4 high   

 Forms 1 high   

      

Totals    149 197 

 

The implementation of the requirements rated high by the JACoW team would 

take 149 weeks of work, or the equivalent of 3 years and 3 months of work for a 

project associate staying at CERN.  

 

The implementation of all the requirements would take 197 weeks of work, or the 

equivalent of 4 years and 5 months of work for a project associate staying at 

CERN. 
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